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Yesterday, I was at a party. There were three of us
who were not Nicaraguan. I started talking to one
of the other two. He moved here from the US. He
even worked at Microsoft and, like me, had lived
in Seattle. The expected conversation followed.

He asked what work I had done in Seattle. I
told him the same work I do here—publish two
Linux magazines. After he said the obligatory, “oh,
you work for the enemy”, we talked more serious-
ly. His knowledge of Linux was from a few years
ago, and it was interesting to see his perspective.
If you have been using Linux for a few years, you
won’t be surprised. If you still haven’t given Linux
a try, maybe this will inspire you.

We never talked security, reliability or trashed
the other product. It was very much him telling me
what he had “learned” and me pointing out
today’s reality. Note that both of these guys left
with Kubuntu DVDs in order to give Linux a try.

His first statement was that Linux was free, but
it was the maintenance and administration that
cost much more. I talked about how Linux admin-
istration has gone from command-line, UNIX-like

work to automatic free updates and graphical
administration tools. I expect when he plays with
the Kubuntu DVD, he will see this is the truth.

IF YOU STILL HAVEN’T GIVEN

LINUX A TRY, MAYBE THIS WILL

INSPIRE YOU.

He then told me that Linux was not used by
businesses. I first pointed out that there are more
Linux and Apache-based Web servers on the
Internet than there are Windows with IIS Web
servers. He seemed surprised. Actually, most peo-
ple seem surprised by that one. The reality is that
Microsoft tried, multiple times, to turn the Internet
into an extension of its products and failed. With
the Internet being there first, it is logical that it
remains independent.

P2P

FROM THE PUBLISHER

Preaching to the Unconverted
See, Nicaraguan parties have side benefits.
PHIL HUGHES
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I also talked about government agencies in Costa Rica
using Linux. The first was when the Ministry of Science and
Technology converted all its servers to Linux. That is ancient
history now—see http://www.linuxjournal.com/article/5461.
Next, I talked about the Ministry of Health putting in some
Linux servers and converting old Windows-based desktops to
Linux thin clients so that the users would still have the same
computer on their desks but everything would be much faster.

Then, I went out on a limb and said that in the future,
Microsoft would be replaced as the primary supplier of soft-
ware. He agreed, but said that the new system wasn’t here
yet. Knowing that Microsoft makes most of its money by sell-
ing Microsoft Office, I pointed out that most people don’t
know or care what an operating system is, and today,
OpenOffice.org is a perfectly viable office suite that runs on
MS Windows as well as Linux.

He listened. He heard. He has the Kubuntu DVD. I now am
waiting anxiously to see what happens. Will he come back
and tell me that Linux doesn’t work on the desktop? Will he
come back and agree that everything he needs is right there
in an easy-to-use and free package? I don’t know what the
result will be, but it was a pleasure to get to talk to someone

who was willing to listen rather than to someone with an “if
it ain’t Microsoft, it doesn’t work” attitude.

Finally, I want to offer a quick update on what I said in my
column last month. First, a beta version OpenSUSE 10.2 has
been released. The production release probably will be out by
the time you read this. This desktop is still running 10.0, so I
have a new excuse not to upgrade to 10.1.

Last month, I talked about my experience with the pre-
release of Kubuntu Edgy Eft. The final release is out, and I
upgraded to it on one of my test systems. I am pleased to say
that all the problems I found in the pre-release did get fixed
in the final version. Dapper Drake still remains the version that
will be supported for the long term, but if you want to try
what’s new, I now can say that Edgy offers a reliable 
alternative.

Of course, as I said last month, there is just no one 
right answer. The good news, however, is that all Linux 
distributions continue to be easier to install, work on more
hardware and are easier to maintain—all big wins for the 
new Linux user.�

Phil Hughes is Publisher for TUX Media, Ltd.
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THEN, I WENT OUT ON A LIMB AND SAID THAT IN THE FUTURE, MICROSOFT
WOULD BE REPLACED AS THE PRIMARY SUPPLIER OF SOFTWARE.
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FROM THE EDITOR 

Time to Celebrate

I have never been into holidays. This
doesn’t mean that I am a workaholic
(even though a lot of my friends would
probably say that I am). It’s just that I
have always been lucky in my life, and
apart from 11 sad months, I have always
been able to work “in my own time”.
This normally means “a rather lot”, but
it’s my own choice and freedom to do so,
at least in theory. So, I observe the out-
side world change: I see Easter eggs
appear on supermarket shelves and
imagine huge chocolate hens laying
them. I see timid Christmas trees appear
in July, for those people who are surpris-
ingly determined to have Christmas in
winter. I see severely over-dressed Santa
Clauses strolling the street with sweets of
Fremantle, as their wet faces admit that
they are going through an unkind varia-
tion of a sweat lodge. Lately, I also realise
that I see computers following the same
path as real life: screensavers, wall
papers, splash screens, colour themes,
games—they often seem to converge
toward the “Holiday Season” theme.

Also, I have started seeing more and
more cards that break the rules of the
normal Christmas cards in several (some-
times unspeakable) ways—cards that
were created ad hoc by senders with
their PCs.

Although I am not a great follower of
all of the nativity packages, I must say
that I enjoy seeing people making an
effort to sweeten the way the world and
their computers look. Linux has a lot to
offer as far as customisation, and, unlike
Windows, you can do so without fearing
Trojan screensavers and other such
Christmas “presents”. So, this issue of
TUX focuses on how to use your com-
puter this holiday season.

In his article “Nativity on Your Linux
Desktop”, Dmitri Popov explains exactly
what to do to create nice Christmas
cards using Linux. This article will be
most welcome by all those people who,
before now, had a big entry in their
budget dedicated to Christmas cards!

Jay Kruizenga tells you how to make
your Linux desktop look “right” for the

holiday season, and—maybe even more
important—how to use Linux to keep up
with your New Year’s resolutions.

Mango Parfait shows off her magnifi-
cent skills while answering questions
about printing and opening Konqueror
windows as root. I nearly rejected her
article when I saw all those GNOME
screenshots! Then, we talked through it,
and she told me she’d do anything for
the sake of our readers—and proved it!

Colin McGregor inaugurates the
beginning of a new column: “TUX
People”. Each month, we will interview a
relevant person in the Linux world. This
month, Colin had the honour to inter-
view Pamela Jones from Groklaw. Thanks
Pamela!

Phil Hughes covers two important
topics in Linux: how to manage groups
and Linux Edutainment. Even if you are
not really interested in these topics, I
think these articles are a must—read
them, and you will see why!

Brian Jones also starts a new column
in TUX this month: “Linux Commands”. 

Your PC needs a holiday (theme) as well.
TONY MOBILY
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Yes, we have given in; we are indeed going to talk about the
feared command line. However, we will do it the TUX way: sim-
ple, simple, and again, simple. I am sure many of you will enjoy
Brian’s simple articles, which will give simple explanations on
how to use simple commands. You get the message.

Dmitri Popov talks about how to create very basic programs
using OpenOffice.org. Although this is programming strictly
speaking, we feel that what we talk about is definitely within
reach of most of TUX readers. Dmitri will provide practical code
examples for using OpenOffice.org at its full potential.

Willy Smith talks about partitioning a second hard drive for
backups and music. I feel that too many people use “luck” as
their main backup. However, just like anything else, luck runs
out. Hopefully, this article will convince a few readers to install
an external hard drive in their PCs and back up away....

Jay Kruizenga covers a topic that is highly in demand at the
moment: “Where to Buy Linux PCs”. When he proposed the
article to me, I answered, “yes”, immediately. In fact, I might
have broken a few laws of physics by answering “yes” before I
had actually received his message. The resulting article is a fan-
tastic resource, which will hopefully convince people to buy
hardware from those manufacturers who love and support
Linux.

Finally, Travis Kepley compares Unreal Tournament 2004
under Linux and Windows, and Matija Suklje talks about
Planeshift. For those readers who are addicted to video games,
beware!

Well, it’s time for me to let you go and devour this issue of
TUX. As always, comments and suggestions are welcome. As
many of you may have noticed, we actually do listen! Enjoy your
holidays.�

Tony Mobily (BSc) is a computer consultant, journalist and Zen Buddhist. He lives
in Australia working as a magazine editor and consultant. Tony has been an
active member of the Open Source movement for many years. In 2004, he
founded Free Software Magazine, a popular publication about free and open-
source software. He is also the author of the book Hardening Apache and sever-
al articles about Linux and open-source software.

P2P

6www.tuxmagazine.com

http://www.tuxmagazine.com
http://www.spidertools.com


P2P

7www.tuxmagazine.com

Requests
I am newbie to Linux. I installed SUSE Linux 10.1 on my laptop
computer, because I got tired of having to pay for new ver-
sions of MS Office, Photoshop and so forth. I installed SUSE
following the instructions of the e-book: The Easiest Linux
Guide You’ll Ever Read, An Introduction to Linux for Windows
Users by Scott Morris. I read all his suggestions, followed the
screenshots for the installation process, and selected what I
wanted to install in SUSE 10.1.

However, I was wondering if a near-future TUX magazine
could show us a programming column with simple stuff, like
how to create a small program and compile it and how to
write a basic script, and also, how to install software using the
terminal with screenshots as Scott Morris did. This would make
us fell more confident, and it would be of great help when
using the terminal, especially for people like me who do not
have any background in Computer Sciences (I am a graduate
student in Crop Sciences), but who are willing to learn Linux. I
want to be able to install all the software I need to do my
research with Linux, and also, I want to show my labmates and
classmates that the migration from Windows to Linux is possi-
ble.
--
Michael

You are in luck, Michael! We received several requests, and I
am happy to announce that I have already organised a

“OpenOffice.org Programming” column and a “command-line”
column. They will be very, very basic—aimed at the beginner
users. I am sure you will find them interesting!—Ed.

On Microsoft
In the November 2006 Letters section of TUX, Bill Cupp wrote
that Microsoft did not help spread the use of computers. I
don’t wholeheartedly agree. I do believe that, even without
Microsoft, computers eventually would have been widely
accepted. However, it was Microsoft that led to the break-
through of using an OS on different hardware. At the same
time, do realize that this was less because Microsoft wanted
computers to be used widely, than it was because Microsoft
wanted to make all the profit it could (which is, in a way, logi-
cal). The popularity came because those otherpersonal com-
puters were clones of the popular IBM microcomputer.

Additionally, more about the Microsoft bashing: you also can’t
deny that we do not have reasons to bash Microsoft. In the
Netherlands, we have this saying “de klant is koning”, which
means that you have to put the customer first, and it is some-
thing that all companies say they do (surely there’s an English
saying for it too). Anyway, apparently a company (or perhaps
just Microsoft) does not put the customer first if it is in a posi-
tion where it would not matter if it put the customer first,
because if it does not, it’ll sell anyway. Look at Internet
Explorer, and how Microsoft has come to work on it only now
that Firefox has been eating its market share. If we now let IE

LETTERS
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become dominant again, Microsoft will stop developing again.
However, no matter how small its market share is, Firefox will
continue to innovate.

All in all, I see no problem with Microsoft bashing, as long as
you do it in a reasonable tone, with reasonable arguments,
and only if it’s relevant (that is, if someone asks a question,
answer it, or don’t, but don’t go complaining).
--
Vincent

Thanks for your letter, Vincent!—Ed.

KShowmail
Kevin Vollick, in a letter to Mango Parfait [November 2006],
asked about a Linux program to examine mail headers and
delete the unwanted ones before downloading. KShowmail
does this and is quick and easy to use.
--
Sandy Runcie

Thank you Sandy!—Ed.

Need Printing Help
I, like many others, get a lot of help and news from your mag-
azine. In fact, I’ve downloaded all the back issues, and there is
much I’ve learned from them.

When doing your review of printers (which I read you are
preparing), could you give some space to finding ways for
using printers that don’t provide drivers? In particular, I’m

referring to Canon printers. A year ago, I bought a Canon i865
for the main purpose of printing photographs. It works great
with Windows, but a few months ago, I made the leap and
now work only in Linux. The only leftover from that (happy)
choice of mine is the inability to get my printer to give me the
full benefits for printing photos under Linux. I tweaked around
until I got it to print using some generic driver, but if I want to
print photos, I have to print from my wife’s computer, which
still runs Windows.

I know about Turbo Print, but I feel to pay more money for a
driver is sad.
--
Errol

Errol, I think it’s important to do our best and explain to peo-
ple how to get unsupported hardware to work in Linux.
However, I feel that it’s even more important not to buy hard-
ware from Linux-unfriendly companies, so that they get a clear
message on what they should do.—Ed.

On Mice and Adept
With regard to the letter from Terrence Dreyer [November
2006], I am currently using a Logitech Marble Mouse with
Kanotix—no problems. Mine is several years old. A friend has
a new one (it has two more buttons), and it also works fine in
Kanotix. I don’t see why any other standard PS/2 or USB
mouse shouldn’t work in Linux without any specific drivers,
unless they have some special function(s). Of course, I cannot
say these mice will work on any other specific distros for sure.
Kanotix has the best hardware support of the 15 or so distros

P2P
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that I have tried, and the best and most helpful forums.

Adept was included in an RC release of Kanotix, and most
users seemed to want KPackage back, or Synaptic. Adept had
one extremely glaring flaw. It had no way to install a .deb
package from CD or hard drive. I am using a modem and a
dial-up connection, so from CD or hard drive is the only way
to install my modem driver. Without the modem, of course, I
couldn’t install any other packages. I finally ended up using
alien to install the modem driver. Then I used Adept to install
KPackage. Then Adept got removed. Adept also caused Apt
not to work. Even when Adept was not running, trying to
apt-get packages gave me an error, saying something like the
package folders were locked by another application. Until
these flaws are fixed, I would not recommend Adept to any-
one. If you want to try it, make sure you have Synaptic or
KPackage already installed!
--
KBOHAE

Games, Cedega and Freespire
Many thanks for a very useful and informative “magazine”—I
look forward to reading it!

There’s just a couple of items I thought I’d like to comment on.

While I agree in general, with Evan Thomson’s letter [October
2006], concerning game coverage, I’d like to voice an opinion
that there are people who are not looking at getting the very
latest games working on Linux (although it is nice, and attrac-
tive for new users). There are many “old” games that are very

playable, and that I’d love to see on a Linux screen. Personally,
I was very pleased to see Tomb Raider. The only thing I’ve ever
found is that I’ve never had much success with Wine (other
than getting notepad to work!). Is there any possibility of a
masterclass? Or, for that matter, do you know of any sites that
give detailed step-by-step instructions on getting these pro-
grams to work?

Having bought Cedega, I was very disappointed with the pro-
gram. None of my Windows games worked (most didn’t even
install), which is why I was a little saddened by the very pro-
Cedega review you did a little while ago [September 2006].

On a different tack, I note you say Linux is ready for the desk-
top. I very much second that opinion. To date, I’ve been run-
ning SUSE 6.4 through to 10.1, and I’ve been impressed.
However, I’ve also now installed Freespire and I was very
impressed by the simple and straightforward operation, and
most of all, the Click and Run software installation worked
very well indeed. While a hardened Linux user may say that
such facilities are a dumbing-down of the desktop, I’m all for
it, as it will attract users, which is never a bad thing.
--
Carl Beech

There isn’t much we can do about games not working using
Wine. Unfortunately, emulation is what it is—emulation, and
it’s not always perfect. A tiny crack means that either the
whole program won’t run or it will crash. Now, it’s time to
lobby game companies so they release games under Linux as
well!—Ed.

P2P
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Excessive KDE Coverage?
I’ve just finished reading the October 2006 issue of TUX, and as usual, it’s
an excellent issue. However, I can’t help but agree with the letter from
Andrew Hawkins, who is dismayed by the excessive KDE coverage. I’ve sus-
pected for some time that KDE gets better play, so I did a non-scientific
review of every issue of TUX, back to the first one.

I excluded editorials, letters and Mango. The result? KDE programs: 36;
GNOME: 12. Reviews of KDE distros (not counting Smackdown): eight.
GNOME distros: one. The October 2006 issue was a perfect example—arti-
cles mentioning five KDE programs and no GNOME programs. You even
tested the Acer laptop with a KDE distro. In fairness, you review many
cross-interface programs and many of the KDE programs will also work in
GNOME.

When I read Phil Hughes’ editorial, in which he referred to getting back on
track with his vision of “bringing newcomers to the desktop and KDE”, I
understood where this KDE bias is coming from. But, consider this: the top
DistroWatch hits are coming to the GNOME flavour of Ubuntu. I have no
scientific basis for saying this, but maybe the majority of Linux “newcom-
ers” that you want to reach are trying Ubuntu. How does that fit with your
vision?
--
Stephen Wilson

KDE is our favourite desktop system. This is not a secret. 
Yes, there is a bias, which is mainly due to the audience of TUX. We feel
that covering both GNOME and KDE would confuse too many people, and
choosing KDE is the best option. However, as you said, most programs will
work on both distributions; so, the difference is not as marked as it
seems.—Ed.�
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I have good questions this month! Thank you very much for your
good questions. They are perfect for a very beautiful, humble
genius like me. I will not tell you a story this month, because I have
many pictures, and they take up a lot of room. Just remember to
keep sending me good questions like these questions.

Q I want to install a printer on the Ubuntu 6.06 OS. It is a
Lexmark x1100. Is there a place to get drivers for printers? I

looked at Lexmark and did not see a driver for this printer. I also
have SUSE 10.1/64 on a machine, and it shows that my Canon
i455 is installed and needs to be configured. How do I configure a
printer?—Mike

A Hello Mike. Ubuntu has a printer driver for the Lexmark 1100
printer. You do not need to find one.

You tell me you run Ubuntu, not Kubuntu, so I think you are
using GNOME. I will not tell you to change to KDE. It is a very good
idea, but I will not tell you that. You will like KDE more than
GNOME, but I will not tell you to change.

You use GNOME, so click System→Administration→Printing
from the main menu. If you do not see Printing in the menu, you
must install gnome-cups-manager. You can use any package man-
ager. If you want to type a command, click Applications→
Accessories→Terminal. Then, type this command:

$ sudo apt-get install gnome-cups-manager

You must do this only if you do not see Printing in the menu. If
you see Printing in the menu, never mind this part. After you click
System→Administration→Printing, you will see a window like the
one shown in Figure 1.

Figure 1. Printers Configuration Window

You see that I have a Samsung printer? Maybe you have one
too. Maybe not. It does not matter, because you will see New

How to install a printer in GNOME and KDE and open files as root in KDE.
MANGO PARFAIT

Q&A with Mango Parfait

http://www.tuxmagazine.com


Printer. Double-click on the New Printer icon. You will see a window
like the one shown in Figure 2.

See my Samsung printer in my window? Maybe you do not see
any printer there. Maybe you see your Lexmark printer. I do not
know. I think you can click the Forward button anyway. You will see
a window like the one shown in Figure 3.

See the selecting thing next to Manufacturer? If this does not say
Lexmark, click on this and choose Lexmark from the list. Now, select
1100 from the list of printers. Click the Forward button. Now, you
will see a window like the one shown in Figure 4.

I typed MyLexmark for the Description and Office for the
Location. You can enter whatever you like. Now, click the Apply but-
ton. You are done! You see the Printers window now looks more
like the one shown in Figure 5.

P2P
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Figure 3. Step 2 for Adding a Printer

Figure 2. Step 1 for Adding a Printer
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My computer still thinks Samsung is the
default printer. If I want to make 1100 the
default printer, I right-click on the 1100 icon,
and select Make Default.

Maybe I am wrong, and you have good
taste, and you use KDE. Maybe you do not
use KDE, but some readers have good taste
and use KDE. I will tell you and those readers
how to set up the Lexmark printer in KDE.

Click on the main menu on the toolbar,
and click System Settings in the menu. You
will see a window like the one shown in
Figure 6.

Click the Printers icon. You will see a
Printers System Settings window like the one
shown in Figure 7.

It is good to use Administrator mode.

Click the Administrator Mode button at the
bottom of the window. Type your user pass-
word when it asks you for a password. You
do not type the administrator password,
because if you are using Ubuntu the right
way, there is no Administrator password.
You type your user password. You will see a
window like the one shown in Figure 8.

Click Add→Add Printer/Class in the main

menu. You will see a window like the one
shown in Figure 9. This answer has a lot of
figures. Do you think so? It has many more!
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Figure 4. Last Step for Adding a Printer

Figure 5. Printers now includes the
Lexmark 1100.

Figure 6. KDE System Settings

Figure 7. KDE System Settings for
Printers

Figure 8. Printer Settings in Administrator
Mode

http://www.tuxmagazine.com


There are many windows in the KDE Printer
wizard. You see the first window now. It
looks like Figure 9.

Click the Next button at the bottom of
the window. You will see a window like the
one shown in Figure 10. Do not worry; there
are many more windows, as I say.

Click on Local printer (parallel, serial,
USB). I think you have your Lexmark con-
nected this way. Click Next, and you will see
a window like the one shown in Figure 11.

My window has my Samsung printer. I
hope you see your printer, not my Samsung.
If you see your printer, click on the name. If
you do not see your printer, click on the con-
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Figure 9. The KDE Add Printer Wizard Figure 10. Select the type of printer 
connection.

Figure 11. Select the printer to configure.

Figure 12. Select your printer brand and
model.

I RUN GNOME TOO, BECAUSE I NEED TO ANSWER GNOME QUESTIONS.

Figure 13. The Settings and Test Screen
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nection you are using. If it is a parallel print-
er, click that. If it is USB, click that. Click
Next. You will see a window like the one
shown in Figure 12.

Click on LEXMARK, and click the model. I
think you want to click 1100 lm1100. Click
Next, and you will see a window like the
one shown in Figure 13.

I think you should click the Test button.
This is a good idea. If you make the right
choices before this screen, you get a test
page on your printer. If you do not get a test
page, you need to go back and change the
settings to make them right. Click Next
when a test page works. Some of the next
pages in the wizard are not important, so
keep clicking Next to see the windows 
like the ones shown in Figures 14, 15 and
16, and then stop when you see one like

Figure 17.
Like I said for GNOME, I typed

MyLexmark for the Description, and Office
for the Location. You can enter what you
like. Click Next, and you will see a window
like the one shown in Figure 18.

I do not have a Lexmark printer, so the
information in Figure 18 is not right. I hope
it is right for you. Click the Finish button,
and you are done!

Q Hi Mango. Thanks for your article enti-
tled “Add Custom Actions to Your

KDE Konqueror Pop-up Menus” [see the
December 2005 issue of TUX]. It works great
on my Dapper Kubuntu.

I would like to have a script so that when
I right-click on a folder, it lets me “Open as
Root” (I have such a thing in GNOME).
Then, I can use Konqueror to move/

delete/edit files in system folders.
I don’t know what to put for

ServiceTypes. I’m also not sure if I should use
one of the % options like %F or %d.

If you have the time and are so inclined,
I’d love some help.—Satyam

A You are smart and have good taste
because you run KDE! I want Mike to

meet you. Maybe you can tell Mike why he
should run KDE. I see you run GNOME too,
but that is okay. I run GNOME too, because I
need to answer GNOME questions. Maybe
you need to answer GNOME questions, or
maybe someone is making you run GNOME
sometimes.

Okay, I have an answer for you. Actually,
I have four answers for you! The first answer
is that you can look for features like this at
the Web site http://www.kde-apps.org. I get
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Figure 14. You can choose whether you
want a banner page, but it is not needed.

Figure 15. You can skip the quota page
too.

Figure 16. You can skip the page to tell
KDE not to let other users print here.
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some of my ideas from this site. This is a good site to find service
menus and other nice KDE programs. But, you do not have to go
there. I have three more answers. I will teach you how to add three
actions to your Konqueror menus. You use the first action to run any
file as any user. The second action is to open any file as root. The
third action is to run any file as root. You do not need all three. You
can use the first one to open a file as root, because it makes root the
default. I use all three because I think it is easier.

First, you create a file called open as user desktop, and save this
file anywhere for now. Here is what to put in the file:

Encoding=UTF-8
Actions=OpenAsUser
ServiceTypes=all/all

[Desktop Action OpenAsUser]
Name=Open as user...
Icon=kuser
Exec=kdesu -u `kdialog --inputbox "Enter username:" 

�root` -c "kfmclient exec %u"

Now, you must save the file and move this file to the right place.
Here is the command:

$ mv openasuser.desktop ~/.kde/share/apps/konqueror/servicemenus

This command works if you open a terminal and you are in the
directory where you save the file. You can use Konqueror to move
the file as well, but I think you are smart enough to use a terminal
and commands.
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Figure 17. Description and Location Page Figure 18. Final Wizard Page with Information about the Printer
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If you have Konqueror open, you need to restart Konqueror.
Now, right-click on a file and click Actions→Open as user to get a
window like the one shown in Figure 19.

Click the OK button. KDE will open the file as the user.
Maybe you just want to open as root always. Make a new file

called openasroot.desktop, and put this in it:

[Desktop Entry]
Encoding=UTF-8
ServiceTypes=all/all
Actions=OpenAsRoot

[Desktop Action OpenAsRoot]
Name=Open as Root
Icon=kuser
Exec=kdesu "kfmclient exec %u"

Now, you must save the file and move this file to the right place.
Here is the command:

$ mv openasroot.desktop ~/.kde/share/apps/konqueror/
�servicemenus

Maybe you want to run a file as root always. Make a new file
called runasroot.desktop, and put this in it:

[Desktop Entry]
Encoding=UTF-8
ServiceTypes=all/all
Actions=RunAsRoot

[Desktop Action RunAsRoot]
Name=Run as Root
Icon=kuser
Exec=kdesu -c

Now, you must save the file and move this file to the right place.
Here is the command:

$ mv runasroot.desktop ~/.kde/share/apps/konqueror/
�servicemenus

Restart Konqueror, and right-click on a file. Click Action, and then
pick the new action you want. If you make a mistake with the serv-
ice files, sometimes KDE will get confused and it will not work. If you
make a bad mistake, you must log out and log in again after you fix
it or it will never work because KDE might run some services wrong
and not stop them. You stop them when you log out.�

I am a sweet, humble, delicate and very cute genius who is at your service to answer
your Linux questions. Send your questions to mango@tuxmagazine.com. I am deeply
sorry that I do not have time to respond to anyone directly by e-mail, but I will select
as many questions as I can and answer them here.
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Figure 19. Type another user name if you do not want the root
user to be the default.
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Pamela Jones

This is the first of a series of articles on people in the Open
Source community. This month, we interview Pamela Jones.

Since May of 2003, Groklaw (http://www.groklaw.net) has
been documenting legal issues of interest to the Open Source
Software community. Although many legal topics are covered,
the SCO Group lawsuits have been a central part of Groklaw
coverage. The person behind Groklaw is Pamela Jones—or PJ,
as she is known to many—helped by a loosely knit collection of
volunteers.

CM: How did you get involved with open
source in general and Linux in particular? 

PJ: I was working in a small law office, and I ended up
being the designated person trying to handle all the comput-
ers. The office was too small to have a tech department, and I
was appointed. It was an education. Being a Windows office,
and full of clueless folks, it was a nonstop battle with viruses
and blue screens of death and apps that didn’t work any more
(“What did you do just before this happened?” “Nothing.”). A
relative told me about Knoppix and Red Hat, and how in Linux
you wouldn’t have all those troubles. I also learned on investi-
gation how to use Knoppix as a live CD to fix troubles in
Windows. It was mind-blowing. I couldn’t get over that the
GPL meant I didn’t have to register or type in numbers proving
who I was, and that I could share with as many people as I
wanted.

The author of the Web site that sank the SCO ship.
COLIN MCGREGOR

Pamela Jones as drawn by J.D. “Illiad” Frazer of
UserFriendly.org. Copyright 2005, Pamela Jones.
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So, although I actually enjoyed Windows up until that point (I
just love using computers), using Red Hat and then Mandrake,
now Mandriva, and Knoppix and Kubuntu...little by little, I
found myself using the Linux side of my dual boot more and
more instead of the Windows side. And, eventually, I just moved
over and got rid of the Windows side. I do also use a Mac OS X
laptop, and I have just downloaded Yellow Dog Linux and
Kubuntu, and I’m hoping to have time to play with them on
that hardware eventually. Groklaw is very time-consuming, and I
don’t get to have fun with learning new things the way I 
used to.

That is the fun of Linux to me—that you can try things out,
and you can learn. I think it’s incredibly interesting to look at the
logs, and at changes in files, and to be able to understand that
computers don’t do things magically or unknowably—that you
can comprehend how it does what it does, and then you can
tweak it to make it do what you want very precisely, instead of
getting to do only what the computer is set up to do by a
stranger at a company who doesn’t know you or what you
want your computer to do.

CM: What do you see as Groklaw’s main role in
the community? 

PJ: Education. I started with the idea that geeks don’t know
enough about the law to function well in a digital world, where
all of us are affected personally by copyright law, at a minimum.
At the same time, I certainly knew that most lawyers need to
have more information about the technology in order to handle
cases that require such knowledge. I wanted to put those two
groups together, so they could work together.

I still see that as a primary purpose. And, Groklaw is also a
place where a large group of folks, dispersed over the Internet
in more than one country, can work together effectively doing

legal evidentiary research. In the SCO case, for example, our
readership includes the folks that wrote UNIX and Linux, so who
would know better than they do what happened and where the
evidence is? They lived it.

Finally, Groklaw is an antiFUD site, where we try to educate
against false information corporations sometimes dispense.

CM: What do you see as the biggest legal chal-
lenge currently facing Linux and the Open
Source community? 

PJ: Patents. And, how to keep the community united in the
face of legal challenges, when it has always been somewhat
divided in philosophy and interests.

CM: How would you encourage more women to
get involved with the IT sector in general and
open source in particular? 

PJ: By doing it myself. I have found more and more women
becoming members of Groklaw. In the beginning, I was literally
the only one. That’s not true any more at all. It would help a lot
if guys treated women who show up with respect. Although I
am treated very well, it’s still true that for some reason, there
seems to be an idea that women in tech must also be rated on
appearance, not only on ideas and skill. Imagine how men
would feel if, say, Alan Cox or RMS were rated on that. Linus
would do all right, and Ingo Molnar is a bit of a hunk...oops.
Now I’m doing it.

But do you see how weird it is to rate people by something
that certainly doesn’t matter when we’re all working on the
Internet, the most faceless of environments? It’s very off-putting
to women when they offer an idea or some code and they get
asked on a date instead of being taken seriously, or a guy
assumes that the woman can’t possibly know what she is talk-
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ing about, even when she actually does. I
can’t tell you how often that has happened
to me, or did happen in the beginning.
When it happens to me, I’ve learned to
stand up for myself, but I shouldn’t actually
have to. Women tend to underestimate
themselves already, so when they get
stomped on, they are very likely to believe
it. I almost shut Groklaw down in the
beginning, because so many people told
me that there was no way the Linux Kernel
Personality had any kernel code in it. I had
found some evidence that it did. But it was
like an avalanche of negativity, so at first, I
thought I’d made a mistake so huge I
should just stop. I’m not a programmer,
after all, so the possibilities of mistakes are
higher than if I were, and I recognized
that. But I do know how to research, and I
have tech advisers, and I’d found this
thread to pull, and after a bout of insecuri-
ty, I pressed on, and eventually I found out
which version it was. This was later con-
firmed in a SCO deposition, so everyone
who derisively had told me I didn’t know
kernel code from my eyeball were simply
wrong. They assumed I couldn’t know
what I was talking about. But I did. So I tell
women to ignore such things, to know
what they know, to accept their own skills,
and if they believe they’ve done good
work, to stand their ground. It isn’t just the
guys that need to change; we do too. Tech

is all about brains. That’s not a gender
thing.

CM: What else would you like
readers of TUX to know about
you? 

PJ: Not a thing.
Just come and help out. I’d love to have

you join us. The more the merrier. It does-
n’t matter how small each individual’s con-
tribution might be. Others can build on it,
and that is the power of group work.�

Colin McGregor works for a Toronto-area charity,
does consulting on the side and has served as
President of the Toronto Free-Net. He also is secretary
for and occasional guest speaker at the Greater
Toronto Area Linux User Group meetings.

I STARTED WITH THE IDEA
THAT GEEKS DON’T KNOW
ENOUGH ABOUT THE LAW
TO FUNCTION WELL IN A
DIGITAL WORLD, WHERE
ALL OF US ARE AFFECTED
PERSONALLY BY COPYRIGHT
LAW, AT A MINIMUM.
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Just because it’s Christmas time, that doesn’t
mean you have to turn off your computer.
Although you can’t use Linux to make egg nog or
bake Christmas cookies, you can use it for all sorts
of creative things, such as designing Christmas
cards and desktop background pictures. All you
need is Inkscape, The GIMP (both available
through the Ubuntu repository) and a scanner.

CREATING A CHRISTMAS CARD
Instead of buying Christmas cards this year, why
not create them yourself? This way, you not only
will add a personal touch to your season’s greet-
ings, but you also will impress your friends and
family with your Linux skills and creativity. The
only software you need for this project is the
Inkscape drawing application. It’s available with
most major Linux distributions, and you can install
it using your distribution’s package manager.

Next, you need a picture that you can use as a
key motif for your Christmas card. If you have a
digital camera, you can take the picture you want
or choose an existing one from your photo collec-
tion. Alternatively, you can find a picture suitable
for your project on the Web. In fact, there are
quite a few Web sites that offer free, high-quality
photos. Stock.xchng (http://www.sxc.hu) is one of

the best on-line resources containing more than
250,000 photos from which to choose. Using the
search feature on the Web site, you quickly will
find a picture you like. You also might want to try
morgueFile (http://morguefile.com) or the
Yotophoto search engine (http://yotophoto.com),
which allows you to find free photos on the Web.
(In case you’re wondering, for this project, I chose
a picture I took during my winter vacation in St.
Wolfgang, Austria.) Once you’ve found the picture
you like, download it and launch Inkscape.

When you start Inkscape, it creates an empty
document, but before you can start working on it,
you have to adjust its properties. To do this,
choose File→Document Properties. First, choose
the page orientation for your document. The
Landscape orientation is a good choice as that’s
what’s used in most classic card designs. Next, you
need to specify the dimensions of your card. The
actual size of the card depends on whether you
plan to print the card. If you want to send the
final Christmas card via e-mail or put it on your
Web site, the dimensions of the card are not too
important. However, if you are going to print your
design, you need to adjust the card’s size to the
paper format you will be using. For example, if
you have a photo printer, you can use the stan-

Nativity on Your Linux Desktop
The fun side of Christmas cards and desktop backgrounds.
DMITRI POPOV
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Figure 1. Specifying Document Properties
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dard 4"x6" photo paper to print your cards. To
adjust the document’s size, select Inches from the
Units drop-down list in the Document Properties
window, and set Width and Height to 6 and 4
inches, respectively. Close the dialog window, and
you are ready to go.

Start by inserting the photo into the empty
document. To do this, choose File→Import, and
select the image. To scale the image to fit the
card, press and hold the Ctrl key while dragging
the bottom-right black arrow with the mouse.
Once you’ve placed the image correctly, you can
lock it to avoid accidental changes. To do this,
choose Object→Object Properties, and tick the
Lock check button.

Tip: it may happen that the selected image
doesn’t fit the 4"x6" card, because of the

“wrong” aspect ratio, but you can fix that quickly
using The GIMP. Open the image in The GIMP,
choose the Crop tool (it looks like a knife), then
select the entire image. In the Crop & Resize dia-
log window, set the Aspect ratio field to 1.50,
adjust the cropping area, and press the Crop but-
ton. Save the resulting image, and import it into
Inkscape.

Now, let’s add the “Merry Christmas!” greet-
ing to the card. Choose the Text tool from the
Toolbar, click on the document in the spot where
you want the greeting to appear, and type the
text. Choose Text→Text and Font, and select the
desired font and size. Keep in mind that chunky
fonts will look best on the card, so you might
want to try something like Bitstream Vera Sans
Bold or one of the decorative fonts installed on
your system. So far so good, but the plain look
and black font color aren’t very exciting, so let’s

do something about it. Choose Object→Fill and
Stroke, and use the dialog window to change the
text’s color and enable and adjust the stroke
paint. As a starting point, you can use the settings
I used for the greeting text in the sample card
(Figure 4):

� Under the Fill tab, the R, G, B and A values are
set to 0, 0, 225 and 75, respectively.

� Under Stroke Paint, the stroke is set to Flat
Color, and the R, G, B and A values are set to
0, 0, 225 and 225, respectively.

If you want to jazz up the greeting text even
further, you can make it flow along a path. Use
the Bezier curve tool to draw a path. If you’ve
never tried working with Bezier curves, getting it
right can be a bit tricky, so you might want to
start with simple straight lines. When the curve is
ready, select both the greeting text and the curve,
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Figure 2. Adjusting the Aspect Ratio Using the
Crop Tool in The GIMP

Figure 3. Working with the Fill and Stroke
Properties

Figure 4. The Final Christmas Card
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and choose Text→Put on Path. This places the text along the curve, and you
can use the Edit path tool to adjust the curves’ nodes and make the text
flow more smoothly. If you want to hide the curve, choose Object→Fill and
Stroke, click on the Stroke paint tab and press the No paint button.

You also can spice up the card by adding stars using the Stars and
Polygons tool. Click the Stars and Polygons button on the main toolbar and
draw a star. In the properties toolbar at the top of the window, you can
tweak the star’s settings, including the number of corners, spoke ratio and
so on. To change the star’s fill and stroke color, use the Fill and Stroke win-
dow (Object→Fill and Stroke).

Finally, if you plan to send the card via e-mail or publish it on the Web,
you need to export it as a bitmap image. Choose File→Export Bitmap. In the
Export dialog window, make sure the Page button is pressed, set the

Resolution field to 72dpi, specify the file path in the Filename field using the
Browser button, and press the Export button.

IF YOU HAVE A SCANNER, YOU CAN CREATE 
A HAND-DRAWN CHRISTMAS BACKGROUND
PICTURE.

CREATING A CHRISTMAS DESKTOP BACKGROUND
Once you’re done with the Christmas card, it’s time to decorate your desk-
top. You can, of course, easily find a nice background picture on the Web,
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Figure 5. Using Kooka to Scan the Drawing Figure 6. Cropping the Image in The GIMP
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but that wouldn’t be much fun, would it? Instead, you might want to try
something more unusual. If you have a scanner, you can create a hand-
drawn Christmas background picture. The main prerequisite is a drawing,
which you either can draw yourself or ask your kids to do for you. Next, scan
it using the Kooka scanning software. It comes with virtually any KDE-based
Linux distribution, and you can use your package manager to install it. Make
sure that the scanner is connected to your computer, and launch Kooka.

Kooka’s default settings work fine most of the time, so you should be
able to get a decent scan even without tweaking different options. The only
thing you need to configure is the scan mode and resolution. For your color
drawing, use the Color scan mode. Because you are going to use the final
image on your computer only, the resolution doesn’t have to be very high—

something between 150dpi and 300dpi is more than enough. Once you
have chosen the desired settings, click the Preview Scan button to see a
rough preview of the scan. Use this to see whether the drawing is positioned
correctly as well as to narrow the scanning area. To do this, select with the
mouse the exact area of the image you want to scan. When everything looks
fine, press the Final Scan button, and wait for Kooka to do its job. Save the
scanned image in the format you want (PNG or JPG are good choices). The
scanned image appears in the default gallery in Kooka, and to save a copy of
it in another location on your hard disk, right-click on the image and select
Save image.

In most cases, the scanned image needs additional tweaking in The GIMP.
The first thing you probably need to do is to crop the image. To do this, click
the Crop button on the toolbar, select the desired area of the image, and
click the Crop button in the Crop & Resize dialog window. Next, scale the
image to fit your screen resolution. For example, if you have a 1024x768
screen, you need to adjust the image accordingly. Here is a simple technique
you can use to do this. Choose Image→Scale Image and set the Width field
to 1024 pixels. Make sure the value of the Height field is equal to or more
than 768 pixels. If it’s not, press the Cancel button and re-crop the image.
Press the Scale button to scale the image. Select the Crop tool from the tool-
bar and set the Width field to 1024 and the Height to 768. Use the upper-
right handle of the cropping area to move it around. Once it’s positioned the
way you want it, press the Crop button. Sometimes scanned images look a
little blurred, but you easily can fix that using the Sharpen filter. Choose
Filter→Enhance→Sharpen, set the desired Sharpness level, and press OK.
Save the image, and you are ready to use it as a background. Choose System
Settings from the K menu, and select your picture in the Background section.
That’s all there is to it. Merry Christmas, everyone!�

Dmitri Popov is a freelance writer whose articles have appeared in
Russian, British and Danish computer magazines. His articles cover 
open-source software, Linux, Web applications and other computer-
related topics.
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Figure 7. Choosing a Background Picture in KDE
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The holiday season often puts us in what you might call the holiday mood—
a mood of love, of kindness, of a desire to do good to our fellow humans,
placing all animosity aside. It’s not an easy task. Still, we do get into the holi-
day spirit, and that spirit leads to the purpose of this article. Here I explain
ease of changing your Linux desktop by tapping into a large repository of
GPL-licensed file downloads, entering your KDE Control Panel and making
the appropriate changes to give your desktop a holiday face lift. I also briefly
touch on a couple of calendaring applications to help you follow through
with your New Year’s resolutions and show you a special Web site where
children can write letters to Santa.

The http://www.kde-look.org Web site is a large repository of file down-
loads (eye candy) specifically for the KDE desktop. The files located here are
GPL-licensed (for the most part); however, I did find a few that were obvi-
ously mislabeled due to their content (images of celebrities or borrowed
images from other Web sites). The GPL-license indicates that the respective
image/file is free to download, change, customize or distribute at will, free of
all legal attachments (in a nutshell). You immediately can see the problem
associated with lifting an image from another Web site, adding a few
changes and labeling the new combined image as “GPL”. That is unethical—
but I digress.

The KDE-Look.org Web site is easy to navigate. The left-hand column lists
all of the content separated by usage: wallpapers, themes, icons, splash
screens and so forth. You can browse each listing by category, choosing to
download the files that catch your interest. Or, you also can conduct a
search, which is found in the right-hand column, by entering the term you

Customizing KDE for the Holiday Season and
Methods for Keeping New Year’s Resolutions
Keep your desktop and your life in sync with the season.
JAY KRUIZENGA

Figure 1. KDE-Look.org is a large repository of eye candy for the KDE 
desktop.
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want to find. Each category of files can be
sorted further using the tabs across the top
marked latest, alphabetical, highest rated
or most downloads.

First, you need to register. In the top-
right corner of the KDE-Look.org site, you
will find a place to do this. It is a simple
process that requires only a user name,
password and e-mail address. Once you
have done this, you will receive a tempo-
rary password via e-mail that you’ll need to
log in for the very first time. Don’t bypass
this important step; from this point on, I
assume you have registered and logged in.

For the purpose of this article, we are
looking for a holiday-related theme. So,
type in searches for Christmas, santa, win-
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Figure 2. The left column shows
the content of KDE-Look.org.

Figure 3. The right column contains a
place to conduct a search.

ter, xmas and the like. You will find numerous options under some
searches, while others will have few. Unfortunately, not a large assort-
ment of Christmas-relative downloads are available, but there are
enough to make our quest for a holiday-oriented desktop successful.
Below are some links to file downloads (with authors noted) that I found
to be fitting. Take a look at your leisure, or feel free to discover your
own. I also have provided a link to official wallpaper downloads of the
new movie Santa Clause 3: The Escape Clause.

To download a file, click Download, and save the file to your My
Documents folder or a location where you will be able to find it later.
Download one or more of the following: wallpapers, screensavers, splash
screens and color schemes.

WALLPAPERS

� A Christmas Eve, 1280x1040, by Rebe Bernhard of Austria is a beauti-
ful shot taken of Rebe’s hometown in Austria on a wintry Christmas
Eve: http://www.kde-look.org/content/show.php?content=34730.

� Snowy Christmas, 1024x768, by Doug Conrad is a mixture of snow,
Tux and snowmen frolicking: http://www.kde-look.org/content/
show.php?content=4112.

� Santa-Tux, 1042x768, by DSC is Tux with a Santa cap:
http://www.kde-look.org/content/show.php?content=32895.

� Other great wallpapers from the movie Santa Clause 3: The Escape Clause
starring Tim Allen and Martin Short are available from
http://www.moviewallpaper.net/wallpaper/
2006_The_Santa_Clause_3:_The_Escape_Clause.html.

SPLASH SCREENS

� Tux-Christmas, by Oliver Bestmann: http://www.kde-look.org/ 
content/show.php?content=19098.

� Seasons-Winter, by Sean Hickey: http://www.kde-look.org/
content/show.php?content=13005.

http://www.kde-look.org/content/show.php?content=34730
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COLOR THEMES

� Keramik Christmas, by Doug Glidden:
http://www.kde-look.org/
content/download.php?content=18038&id=1.

� Christmas, by Doug Glidden:
http://www.kde-look.org/content/

download.php?content=18037&id=1.

Now that you have downloaded a few files, how
do you install them? Open the KDE menu (on the
bottom-left of most Linux PCs), and start the
Control Center.

INSTALLING THE WALLPAPER
Click on Look and Feel and then Background.
Switch to the Wallpaper tab, and select Single
Wallpaper. Click on Browse, and find your newly
downloaded wallpaper. Select the mode you like,
and press Apply.

INSTALLING THE SPLASH SCREEN
The Splash Screen is the screen you see when you
first turn on your PC. Select Appearances and
Themes in the Control Center, then select Splash
Screen. Click Add, and browse your PC for your
newly downloaded splash screen. Select the new

theme, and restart the KDE desktop for this to
take effect.

INSTALLING THE COLOR THEME
This is a bit different. When you click the
Download button, your browser opens a new
window where you should see several lines, as
shown in Figure 5. In your browser, click File and
then Save as; note that the suffix includes .kcsrc.
This is exactly what you want. Save the file to
your PC (in a place where you will find it later 
easily).

Next, click on Theme and Colors. Click Import
scheme, and find the downloaded .kcsrc file.
Now, select your color theme, and click Apply.

You now should have a customized holiday-ori-
ented KDE desktop. Figure 6 shows an example of
my finished product.

WRITE A LETTER TO SANTA
Children can write a letter to Santa at
http://www.emailsanta.com. This is a parent-creat-
ed site that lets kids write a letter to Santa, and it
also provides additional fun things to do. Children
will get an instant personalized letter back from
Santa that must be saved or printed or it will be
lost—very nicely done.
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Figure 4. The top column lets you sort searchable images.

Figure 5. Import .kcsrc files to change color
themes.
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NEW YEAR’S RESOLUTIONS
The holiday season is also a time for reflection—a
time to look back on the past year (or years) and
decide what you most would like to change in
your life. Did you know that the New Year’s reso-
lution tradition can be traced all the way back to
the Roman Empire? The Roman god Janus was
the god of gates and doorways, and it is no coin-
cidence that he is placed at the front of the calen-
dar. As a two-faced god, Janus looks both for-
ward into the new year and backward into the
past—symbolic of the way we look to the past in
order to change the future—thus, New Year’s res-
olutions. We have been doing this ever since.

Most people who make New Year’s resolutions
also break them. Perhaps this is because they do
not put them in writing. According to
http://eHow.com, certain steps can be taken to
accomplish a New Year’s resolution once it is
made, including putting it on paper, marking a
calendar with deadlines, starting immediately and
checking progress daily with the occasional
reward for meeting little goals. To help attain your
New Year’s resolution, it might be helpful to have
a good calendaring application with a place for
personal note keeping and tracking of dates.

One great calendaring application is Evolution,
available through the Debian and Ubuntu reposi-

tories. Evolution, similar to Microsoft’s Outlook
Express, includes integrated e-mail, address book
and calendaring application, useful for keeping
track of that New Year’s resolution. Evolution
includes a place to write memos and tasks, and it
can be a full-featured, all-inclusive program to
assist your goal-setting and record-keeping.

Another great calendaring application is
KOrganizer, from http://korganizer.kde.org (if it is
not already included with your KDE desktop).
KOrganizer is another useful tool for logging your
New Year’s resolution and establishing a schedule
of completion or goal dates where you can
reward yourself for keeping that resolution. The
main objective is to follow through and to take
massive and immediate action. With either of the
above applications, you will have a better chance
of success.

I hope this article has helped you customize
your KDE desktop with a festive holiday theme.
Whatever holiday you are celebrating, I wish you
and yours all the best success and fortune in
2007. Enjoy your loved ones, and have a safe holi-
day season.�

Jay Kruizenga, a former Marine, is an
accomplished Marketer (specialty: E-
Commerce), business owner and aspir-
ing author. He has a deep love for every-
thing pertaining to Linux.
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Figure 6. Example of a Customized KDE Holiday
Desktop

Figure 7. Evolution is a full-featured e-mail/
calendaring program.
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When you first created your login on your computer, it contained two differ-
ent things related to access control: your user ID and your group ID. There is
a one-to-one correspondence between login names and user IDs—that is,
your login name is nothing more than a synonym for your user ID.

Groups, however, are different. Any number of user IDs can be associated
with a group. This part of the Linux permissions system allows you to share
information and access to devices. Let’s start with a simple example.

You likely have a CD-ROM device on your system. You might want to
restrict who can access that device. That is, you might want to allow access
if you are logged in, but not if your kids are logged in.

On most systems, there is a group called cdrom, created with default per-
missions that allow the owner (which will be root, or the superuser) and
members of the cdrom group to access it but no one else. This means that if
you want a certain user to have access to it, you simply can add that user to

the cdrom group.
Let’s look at the process. Click on the K menu, and

select System Settings. Then, select Users & Groups from
the System Administration part of that page (Figure 1).
This will get you to the Users & Groups page, showing
user information (Figure 2).

You can see that there are four users on my system:
ana, fyl, nagio and nx. These are the nonsystem accounts.
Click the Show system accounts box if you want to see
them all.

As we are going to be making some changes, we have
to be in Administrator Mode. Click that button, and enter
your password when prompted. The display will look the

same, except a red box appears around the frame. Figure 3 shows what I got
by clicking on ana while being on the Users tab. You see that her primary
group is ana and that she is not a member of any secondary groups. Thus,
she cannot access the CD-ROM drive.

Working with Groups
Giving the right permissions to the right people.
PHIL HUGHES

Figure 1. Select
Users & Groups
from the System
Administration
section of the
Settings menu.

Figure 2. Users & Groups Page
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Next, I am going to add a new login. It’s
easy—simply click the New button to get to the
User Account window and fill it in. Figure 4 shows
the results on the Detail tab for when I added 
carlos. Note that I added cdrom in the Secondary
Groups box. Note also that before clicking Ok,
you need to click the Password & Security tab and
fill in the password information.

Now, go back to the main Users & Groups
window and click on the Groups tab. Then, check
the Show system groups box, as we want to see
who is now in group cdrom. Find the cdrom entry,
and click on it. The bottom pane shows the group
members (Figure 5). Sure enough, I am a member,
as is my dog carlos, but my wife ana isn’t. (Oh,
don’t tell her.)

While we are here, another interesting group is
admin. In Dapper Drake, members of this group
are allowed to use the sudo command. By default,
the first user is added to this group automatically.

Figure 3. Clicking on ana in the Users Tab

Figure 4. Adding the User carlos

Figure 5. cdrom Group
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Should you want to allow sudo privi-
leges to others, all you need to do is add
the admin group to their secondary
groups list.

One other use for groups is file shar-
ing. This is really no different from device
sharing, which we just did—in Linux, a
device is simply a file. If I wanted to work
on a project and allow access to the files
only to two people (I will pick ana and fyl
this time as carlos isn’t a person), I could
add a new group—say finca for a project
related to our finca—and add us as 
members.

Then, if we want to share a file about
the finca, we simply need to put it into
group finca and set group read and write
permissions. When you create a new
group, the dialog allows you to add the

members, as shown in Figure 6. So, that part is easy. One word of warning,
however; your new group membership won’t become effective until you log
out and back in again.

To change the group and permissions for a file, you can simply go to the
directory with Konqueror and right-click on the icon. Then, select the properties
from the menu (Figures 7 and 8). Select the permissions tab and change the
group permissions to Can Read & Write and the Group Ownership to finca as
shown in Figure 9.

Note, you also must allow group access to the directory where the files are
located. Otherwise, the non-owner won’t be able to modify any files or create
new ones, because to do so requires the directory itself to be modified.

This gives you the basics of the Linux permissions system. Using this informa-
tion will make your system more secure and easier to use.�

Phil Hughes is Publisher for TUX Media Ltd.

Figure 6. Creating a New Group

Figure 7. Properties Submenu
Figure 8. Properties for a File

Figure 9. Permissions Tab
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Linux systems offer many educational resources for
anyone old enough to use a mouse. Deciding what
is a game and what is educational is not an easy line
to draw. For example, Mr Potato Man teaches the
young computer user the needed coordination to
use a mouse along with presenting vocabulary.

Most, but not all, of the programs presented here
are from the KDE Edutainment Project, which
deserves special mention. KDE itself supports multi-
ple languages, and the KDE Edutainment Project fol-
lows that lead.

THE KDE EDUTAINMENT PROJECT
The KDE Edutainment Project has been building use-
ful educational software for more than six years. The
focus of the project is to develop high-quality educa-
tional software for KDE, focusing on school children
aged 3–18. The project goes beyond that, also offer-
ing programs to help teachers with lesson planning
and programs that are of interest to anyone who
wants to learn.

The software can be categorized into vocabulary,
mathematics, science, teaching tools plus some
other miscellaneous programs. You can read about
the KDE Edutainment Project at http://edu.kde.org.
The software is far from static—it continues to be
developed, and most of the programs allow you to
add, modify and reconfigure them as needed.

LANGUAGE TRAINING
Eight language learning programs are offered, and
four programs support multiple languages. The three
exceptions are KVerbos, Kiten and KLatin, which are
designed to help you learn Spanish, Japanese and
Latin, respectively. Let’s look at the other five.

Kanagram is a KDE 3.5 replacement for the older
KMessedWords. This program displays words from
any of several word lists with the letters rearranged
and lets you guess the correct order. Figure 1 shows
a screenshot of the default usage. One of the config-
uration options lets you create new vocabularies,
which include the words and hints.

KHangMan is a traditional hangman game.
Graphically, it offers the choice of two themes. It
supports multiple difficulty levels and multiple lan-
guages. A configurable hint feature is also available.
Figure 2 shows a sample screenshot.

KLettres is geared for both reading and hearing

Linux Edutainment
More than ten options for Edutainment.
PHIL HUGHES
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Figure 1. Kanagram Default Usage
Figure 2. KHangMan
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letters. It offers four levels of instruction. Level one presents you with a letter and
also speaks it. You then type the letter in response. Level two eliminates the dis-
play of the letter, making it more difficult. Levels three and four are like the first
two, except a syllable rather than a single letter is presented.

The speech sounds good, and it works in multiple languages—that is, the let-

HOME PLATE

33www.tuxmagazine.com

Figure 4. KWordQuiz—Preparation for the SAT

Figure 5. KWordQuiz—Running in Multiple-Choice Mode

Figure 6. KmPlot
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ter or syllable is pronounced the way it should be in
the corresponding language. Figure 3 shows an
example of running it at level 1.

There are two vocabulary learning programs:
KVocTrain and KWordQuiz. KVocTrain is a very
sophisticated program, well deserving of its own arti-
cle. Although using it is relatively easy, building the

data files for it can be pretty complicated. For this
article, I focus on KWordQuiz.

KWordQuiz uses a vocabulary file (and, in fact,
can use the same vocabularies as KVocTrain) to pro-
duce tests. Those tests can be in the form of flash
cards, multiple-choice questions or questions where
you fill in the blanks. There is no difference in the
data—users can select how they would like the test
presented.

One of the available files from the list (Figure 4) is
preparation for the Scholastic Aptitude Test (SAT).
Figure 5 shows KWordQuiz running in multiple-
choice mode, right after I got the definition of

datum wrong (on purpose).

MATHEMATICS
KmPlot is one of the easiest-to-understand yet most
powerful programs in the KDE Education Project.
When you first start it, you likely will be looking for a
complicated way to tell it what to plot. Not so. As its
own documentation suggests, simply type x^2 in the
box at the top and press Enter. You will immediately
see a plot of y = x2.

Although you can customize the display and use
Cartesian or polar coordinates, you can get started
with about zero work. Figure 6 shows four functions
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Figure 7. KmPlot, Edit Display

Figure 8. KBruch

Figure 9. Kig
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I plotted, and Figure 7 shows the edit display you get
to by clicking on Plot→Edit. Note that each function
has a name. KmPlot chose them. So, you then can
reference them in other plots.

You can change the displayed ranges, the colors
and just about anything else about the plots. KmPlot
also has an assortment of predefined functions you
can use. So, although KmPlot is a quick way to show
a child what a sin wave is, it can be used as a serious
tool as well.

KBruch is available for people who hate fractions
but know they need to learn to work with them.
The program offers a test on fraction arithmetic

where you can choose separate addition/subtraction
and multiplication/division practice or both com-
bined, comparisons, conversion to decimals and fac-
torization. For those who want to scare themselves
or a family member, you can specify up five fractions
to be included in a combination of arithmetic 
functions.

The only real configuration options are what
fonts and colors to use. Figure 8 shows a typical
screen.

Kig is an interactive geometry construction pro-
gram. Besides being a way to explore geometry, it
also can be used to create figures with geometric
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Figure 9. Kig
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drawings for use in other programs. They can be
saved in various formats including PNG, JPG and
SVG (Scalable Vector Graphics).

When you first look at Kig, it seems very intimi-
dating, but that is because the window is littered
with buttons for creating the various shapes.
Although a pop-up help shows you what each sym-
bol means, I find it less intimidating to go to the
Objects menu.

When you select an operation (for example, a cir-
cle defined by three points), you get helper text each
step of the way. Figure 9 shows one example. Note
that you always can press the red stop button to ter-
minate the current sequence.

When in the middle of an operation, the icons on
the left and right are grayed out. Figure 10 shows
the icons. Those on the left are for creating objects,
and those on the right for tests, such as whether
two lines are parallel or perpendicular.

KPercentage lets you practice working with per-
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Figure 10. Kig Icons

Figure 11. KPercentage Options
Figure 12. KPercentage, Doing an Exercise

Figure 13. KStars—Prompting for Your Location
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centages. When you start up the program, you are
offered options as to what level and type of practice
you want (Figure 11). You have choices as to level,
number of exercises and type of exercises. Figure 
12 shows what you see when actually doing an
exercise.

SCIENCE
KStars offers a planetarium for your desktop. When
you start KStars, it prompts for your location (Figure
13). If where you live is in the list, it is simply a cou-
ple of clicks. But, you also have the option of enter-
ing your latitude and longitude. I chose the closest
location, because I know I can modify the latitude
and longitude later. You also are offered a chance to

download additional data.
Once you are set up, the main screen shows a

view of the sky. Make sure your computer clock is
set correctly, as the view is, of course, based on the
current time. You can alter the direction you are
looking, turn on and off types of objects and center
the display on a particular object.

The display is in real time, which means that it
updates to follow the rotation of the earth. Better
than that, it actually can control various telescopes to
keep them pointed where it is pointed. Figure 14
shows the southern sky from here with most of the
options turned on.

KGeography is a basic geography trainer. Figure
15 shows the choices for the current version. There
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Figure 14. KStars, Showing the Southern Sky

Figure 15. KGeography

Figure 16. KGeography Flags Test Figure 17. KGeography Capitals Test

http://www.tuxmagazine.com


are various maps to select from—mostly regions but a few countries. On the
flags test, I didn’t do very well (Figure 16) but made up for it on the capitals test
(Figure 17).

MISCELLANEOUS
KTouch is a typing tutor (Figure 18). Although it’s not as much fun as TuxType
(which I could not capture as it takes over the whole screen), it works just fine. It
contains a choice of lectures in different languages and levels. The high point of
KTouch is the statistics it keeps (Figure 19), which includes a progress graph.

AND MORE
There are many more programs that fit in the Edutainment definition. TuxPaint
certainly qualifies, for example. If you don’t see what you are looking for in this
article, try out the various programs you find in the Edutainment, Games and

Graphics menus and play. If you still don’t find enough, use your package man-
ager to load more. With Adept, you can search for keywords, such as game or 
education.�

Phil Hughes is Publisher for TUX Media, Ltd.
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Figure 18. KTouch

Figure 19. KTouch Showing Statistics
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TUX EXPLAINS

If you’re going to learn only two commands to use on the command line,
I’d vote for ls and cd. Why? Well, because just like in life, if you can’t
move around, and you can’t see what’s around you, it’s quite difficult to
do anything else! The ls and cd commands facilitate moving and looking
around, which can teach you more about the “world” that is your system
and get you ready to perform other useful tasks. Let’s take a look at how
these two commands work.

When you open Konsole, you’re greeted with something that looks
like this:

jonesy@sycamore:~$

This is the command-line prompt. Though it looks a little bit like gib-
berish, the prompt is made up of components that tell you useful things.
For example, the default command prompt, as shown above, tells me
(from left to right), “You’re logged in as user jonesy, on the host called
sycamore, and you’re in your home directory.” Home directories are used
so frequently, they have a shortcut, ~, which is shorter than printing out
/home/jonesy.

So, what’s in your home directory? Simply type the ls command to
find out:

jonesy@sycamore:~$ ls
Desktop  eet138  Photos  Examples  testbin  new-article

There you have it! Now I know what’s in my home directory. Looks
like I have about six things in there, but running ls didn’t tell me whether
they are files or directories. If only there were a way to get a listing that
would show me what these things were instead of only their names. Let’s
try this again, but this time we’ll add a flag to our command to indicate
that we’d like to know what each thing in the directory is, instead of
only the names:

jonesy@sycamore:~$ ls -F 
Desktop/  eet138/  Photos/  Examples@  testbin*  myfile

This is a bit nicer. Anything with a / appended to it is a directory. If
nothing is appended, it’s a regular file. If the @ symbol is appended, the
file is actually the Linux equivalent of a shortcut in Windows. In Linux, it’s
called a symbolic link or symlink for short. Finally, if a file’s name is fol-
lowed by a *, that means the file is an executable file, or program.
Although there are a couple other possible symbols, it’s unlikely that
you’ll run across them very often.

So, now that we know what’s in our home directory, how can we
change directories and enter, say, the Photos directory? To change direc-
tories, we use the aptly named cd command. Here’s how it works:

jonesy@sycamore:~$ cd Photos
jonesy@sycamore:~/Photos$

ls and cd
Finding your way around your computer.
BRIAN JONES

LINUX COMMANDS
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Remember how I said the prompt is there to
give you information about where you are?
You’ll notice that our prompt is now showing
our location as ~/Photos, which means we’re
sitting in the Photos directory, which lives in ~,
which we learned earlier is the shortcut for
home directory (/home/jonesy, in this case).

So, what’s in this directory? Of course, we
lean on the trusty ls command again.
Remember, you can always run ls with no flags
and add flags if you need more information:

jonesy@sycamore:~/Photos$ ls
IMG_2794.JPG  IMG_2795.JPG

Looks like there are two photos in this
directory. Pretty boring. Now, how can I get
back to my home directory? Well, this is also a
task that is performed so often, it also has a
shortcut. If you ever find yourself deep in the
bowels of your system and don’t know how to
get home, you can just type cd with no flags
or arguments at all, and it will take you to your
home directory:

jonesy@sycamore:~/Photos$ cd
jonesy@sycamore:~$

And there you have it! Now you can move
around, have a look at the files on your sys-
tem, and if you ever get lost, you have a quick
way home. With a few minutes of practice,
you’ll be all over the system. And, if you’re
feeling daring, you can run the man ls and 
man cd commands to learn about all of the
other flags and arguments that are available
for these two commands.�

Brian Jones is a system/network/data-
base administrator and sometime
Web developer for the Computer
Science Department at Princeton
University. He is also a freelance
writer and editor, spending most of
his freelance time writing about tech-

nology for various Web and print publications. In his free
time, he enjoys brewing beer, home recording and playing
billiards.
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THE ls and cd COMMANDS FACILITATE MOVING AND LOOKING
AROUND, WHICH CAN TEACH YOU MORE ABOUT THE “WORLD”
THAT IS YOUR SYSTEM AND GET YOU READY TO PERFORM
OTHER USEFUL TASKS.
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Because there are many beginner-friendly languages out there, learning to
program using OpenOffice.org Basic (OOoBasic) may seem like an odd
choice. But, it does make a lot of sense when you think about it. As the
name suggests, OOoBasic is based on BASIC (http://en.wikipedia.org/
wiki/BASIC), a mature programming language designed with beginners in
mind. As such, it has a gentle learning curve, and programs developed in
OOoBasic are easy to read and understand. More important, however, you
can use OOoBasic to control and customize OpenOffice.org—one of the
most popular application suites on Linux. Once you’ve come to grips with
OOoBasic, you can do some pretty amazing stuff. You can, for example,
fetch documents from a remote server with only one click, look up words
from any document in Wikipedia or WordNet, and even develop simple
games. Better yet, you can apply your OOoBasic skills to other programming
languages as well. So, if you at some point decide to move to Python or Perl,
the time spent learning OOoBasic won’t be wasted. If all of this makes sense
to you, read on.

FORTUNATELY, THE OPENOFFICE.ORG BASIC IDE
OFFERS SEVERAL FEATURES THAT MAKE BUG
HUNTING A LOT EASIER, INCLUDING
BREAKPOINTS AND WATCH.
MACROS, MODULES AND LIBRARIES
Before you dip your toes into the programming water, you should familiarize
yourself with OpenOffice.org Basic’s essential concepts and tools.

OpenOffice.org Basic has four basic elements: macros, dialogs, modules and
libraries. Macros are the actual programs that perform one or multiple
actions. Some macros may have dialogs, which are windows and forms that
usually act as a graphical front end, which accepts input from the user and
provides all kinds of feedback. For example, a macro that fetches a Writer
document from an FTP server may have a dialog where the user types the
necessary login information. Macros and dialogs are organized into modules,
which are, in turn, grouped into libraries.

Basic Steps with OpenOffice.org Basic
Programming for nonprogrammers.
DMITRI POPOV

Figure 1. The Macro Organizer allows you to manage macros and libraries.
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This hierarchy lets you easily keep tabs on your
macros. To see how this works in practice, let’s
create a library for your modules and macros.
Choose Tools→Macros→Organize Macros→
OpenOffice.org Basic. In the OpenOffice.org Basic
Macros dialog window, press the Organize button
to open the Macro Organizer, then click on the
Libraries tab. There are two containers where you
can create your library: My Macros and the cur-
rently opened document. (There is also the
OpenOffice.org Macros container, but it’s reserved
for OpenOffice.org’s built-in macros.)

If you choose to create your library in the cur-
rently opened document, it will be available only
as long as the document itself is opened in
OpenOffice.org. In most cases, however, you
might want your library to be available whenever
OpenOffice.org is running. In this case, you should
create the library in the My Macros container.
Select My Macros→Dialogs from the Location
drop-down list, and press the New button. Give
your library a descriptive name (such as

MyLibrary), and press OK. The library should
appear in the Library list. Click on the Modules
tab and double-click on MyLibrary to expand it. By

default, it contains a module named Module1.
Select it, and press Edit or simply double-click on
it. This opens the OpenOffice.org Basic Integrated
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Figure 2. Creating a New Library Using the Macro
Organizer

Figure 3. OpenOffice.org Basic IDE
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Development Environment (IDE), which contains
all the tools you use to write, test and trou-
bleshoot your macros.

WORKING IN THE OPENOFFICE.ORG BASIC IDE
First, you might want to change the default
Module1 name to something more descriptive.
Right-click on the tab at the bottom of the win-
dow, select Rename and type the name you want
(such as MyFirstModule). Using the tabs, you also
can create new modules quickly, bypassing the
Macro Organizer. To do this, right-click on any tab
at the bottom of the window, and choose
Insert→BASIC Module. Using the drop-down list
of existing libraries, you can switch to another
library easily. Select, for example, the Euro library,
and you see several module tabs as well as the
macro in the currently selected module. You can
switch between different modules by pressing on
the tab you want.

To learn the basic functionality of the IDE, let’s
write a simple macro. Clear the main window,
and type the following code:

Sub Tomorrow
Dim Today As Date
Dim Tomorrow As Date
Today=Date()
Tomorrow=Today+1
MsgBox "Tomorrow is: " & Tomorrow
End Sub

Don’t worry about what this code means.
Right now it’s just important to get familiar with
OpenOffice.org Basic IDE. To execute the macro,

press the Run button on the Macro toolbar. The
Run command compiles the macro (that is, trans-
lates it into machine language) and executes it. If
everything works properly, you should see a mes-
sage box containing tomorrow’s date.

ONCE YOU’VE COME TO GRIPS
WITH OOoBASIC, YOU CAN DO
SOME PRETTY AMAZING STUFF.

DEBUGGING YOUR MACRO
Writing macros is probably the easiest part, but
troubleshooting them is a different kettle of fish.
Even the most experienced programmers need
tools to find bugs in their programs effectively.
Fortunately, the OpenOffice.org Basic IDE offers
several features that make bug hunting a lot easi-
er, including Breakpoints and Watch.

Breakpoints are like stop signs in your macro.
Every time the Run command sees them, it pauses
the execution and waits for your further instruc-
tions. Using the Watch feature, you can put one
or several variables in the macro on a watch list
and see what happens to them when the macro
runs. Used together, breakpoints and watch lists
provide an effective way to pinpoint errors in
macros. For example, you can use both tools to
see whether the macro above assigns the correct
date to the Today variable. Type Today in the
Watch field, and press Enter. This adds Today to
the watch list. Now, place the cursor on the
Tomorrow=Today + 1 line, and press the
Breakpoint On/Off button. A red dot appears in

the column to the left. When you press the Run
button, the macro pauses at the specified break-
point (you should see the yellow arrow), and the
Watch window displays the value of the Today
variable, which should be the current date.

The OpenOffice.org IDE also allows you to run
the macro step by step. This can come in quite
handy when you need to get a better idea of the
macro’s behavior during execution. In the Macro
Toolbar, there are three buttons: Step Over, Step
In and Step Out. It’s a bit tricky to explain the dif-
ference between these buttons without getting
too technical, but in most cases, you might want
to use the Step In command to perform a step-by-
step execution of the macro. Simply press the Step
In button, and the yellow arrow appears next to
the first code line. To move to the next line, press
the Step In button again. If you want to stop the
execution process, press the Stop Macro button
on the Macro toolbar.

CONCLUSION
That’s all there is to it. Now you know how to
manage macros in OpenOffice.org and use the
IDE’s tools. In a followup article, we’ll start writing
some real code.�

Dmitri Popov is a freelance writer whose
articles have appeared in Russian, British
and Danish computer magazines. His
articles cover open-source software,
Linux, Web applications and other com-
puter-related topics.
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I’ve talked to a lot of people who have tried Linux, and who would like to
learn more about it, but for one reason or another they are afraid to install it
permanently on their computers. Typically, they are Windows XP users, and
they have one or more applications for which there is no available Linux
equivalent. Unfortunately, what usually happens in this case is that they end
up getting stuck with a limited knowledge of Linux unless they somehow
have a way to use it every day.

The solution to this problem is to install Linux so that you can run either
XP or Linux. Doing that is really much simpler than it might sound, and this
article shows you how to do it in a non-intrusive fashion by installing a sec-
ond hard drive. A second hard drive nowadays is very inexpensive—I picked
up an 80GB drive at a local computer chain store to do this in my system,
and the final cost was only $16 US, including tax. Since I downloaded SUSE
Linux 10.1 from the OpenSUSE site, the total cost for modifying my system
was less than $20 US, including the blank CDs I used.

INSTALLING A SECOND HARD DRIVE
Setting up such a dual-boot system has a number of advantages besides just
allowing you to learn Linux by running it every day. It also means that if you
ever get a dangerous virus on XP (a relatively common occurrence as
Windows seemingly has a never-ending supply of new vulnerabilities), you
can boot Linux and clean the virus from the Windows disk without booting
Windows. This can be important if the virus is destructive and has damaged
essential operating system files. Even if the Windows disk has been damaged
to such an extent that you have to re-install XP, you still can boot Linux and
rescue your data from the Windows drive before you do the re-install.

This article takes you step by step through the installation of both a 

second hard drive and SUSE Linux 10.1. The steps are as follows:

1. Buy and install a second hard drive in your system.

Install Linux on a Second Hard Drive
An economical, safe solution for installing Linux.
WILLY SMITH
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Figure 1. View inside the computer—locate a spare bay and the connecting
cables inside your computer’s case.
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2. Download and burn the five SUSE Linux10.1
installation CDs from the OpenSUSE site.

3. Install Linux on the second drive.

First, remove the left-side cover from your PC
(top cover if it’s a desktop system). You should see
the motherboard and the first hard drive, as
shown in Figure 1.

Although some systems are now using serial
(SATA) drives, most systems still use IDE drives,
which have a wide flat ribbon cable, as shown in
Figure 1. After you verify which type of drive you
need, buy a second hard drive of the correct type
for your system. It’s not necessary to buy a big
drive—although I found an 80GB drive, a 10GB or
20GB drive is plenty. If you have any question
about this, it might be a good idea to take your
system into the store where you are going to buy
the drive, to make sure you’re getting the right
one.

Before you start working on your system, make
sure there is no static electricity present in your

work area that could damage any of the compo-
nents. If you feel any sparks when you touch the
outside of the case, you can get rid of this prob-
lem by spraying the carpet with a little Downy
fabric softener, which has compounds that will
dissipate the static. Alternately, you could move to
an area that has a damp concrete floor. I also like
to unplug the power cord when I’m actually doing
anything inside the case, to be sure I don’t 
accidentally do anything while the power is on.

Locate an empty drive bay and the end of the
data cable, which should come from the first hard
drive. You also will need to locate a spare power
connector, also shown in Figure 1. Now, you need
to set up the drive so it is ready to install. Figure 2
shows the setup for my drive.

In this case, we are installing a slave drive, so I
removed the jumper located at the back of the
drive between the data and power cables 
(Figure 3).

Note that your drive may require you to
change the position of the jumper, or it may
require you to remove it entirely. While you are
looking at the back of the drive, note that there is
a notch on the top of the data cable connector,
and there are beveled edges on the power con-

nector. You will need to plug the cables in to
these connectors correctly, so note their position.
In my system’s case, there is enough room that I
could plug in the cables before sliding the drive
into position. If your case is smaller, you may have
to install the drive and then plug in the cables.

Once the drive is in place, install the mounting
screws, which are supplied with the drive. You
may have to remove the other side of the case in
order to do this.

Now you are ready to verify that the drive has
been installed correctly and the BIOS can “see” it.
Turn the computer back on, but before it boots,
enter the BIOS setup program. This is usually done
by pressing F2 or the Del key while the system is
initially starting up. If in doubt, refer to your com-
puter’s manual to see how to do this. Now, enter
the main setup, change the Primary Slave drive to
auto-detect, and make sure the size agrees with
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Figure 2. Hard drive label—all the information
you need to set up the drive is usually found on
its label.

Figure 3. Hard drive connectors and jumpers—
make sure the jumpers are set correctly, and note
the location of the cable alignment guides.

Figure 4. Installing the drive—carefully install
your hard drive in a spare bay.
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what the drive is supposed to be. There may be
another parameter that you will need to change.
For example, my drive says on the label that I
need to enable LBA mode. The BIOS in my
machine was smart enough to set this by itself,
but it’s a good idea to check it. You also should
make sure that your BIOS is set to prioritize boot-
ing from the CD before the hard drive. This is usu-
ally on the Advanced Setup page.

INSTALLING SUSE ON THE NEW HARD DRIVE
Assuming that you have successfully installed your
second hard drive, make sure it still will boot your
legacy operating system, and we’ll go on to the
software installation.

I’ve used SUSE Linux for several years and have
always bought the “professional” version. But, now
there is a free version available for download from
the Internet, at the http://www.OpenSuSE.org site.
Go to the download page (http://en.opensuse.org/
Released_Version), or follow the Download link
from the home page. Follow the instructions to
determine which version you will be using, and
then use the links in the download matrix to get
all five ISO (whole CD) images.

Note that you can download the images with a
BitTorrent client, or you can simply download the
individual images. Burn all five CDs once you have
finished downloading, making sure that you are
burning an ISO image. I don’t bother with the

MD5 checksum as the SUSE install program will
allow you to check all the CDs before you begin
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Figure 7. SUSE Linux CD media check—using this
dialog, you can verify that the installation CDs you
have made have no errors.

Figure 5. OpenSUSE Linux download matrix—find the correct version of SUSE Linux for your com-
puter and download it here.

Figure 6. SUSE Linux language selection—the
default language for SUSE 10.1 is US English, but
you can choose from many others.

http://www.OpenSuSE.org
http://en.opensuse.org/Released_Version
http://en.opensuse.org/Released_Version
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the install, and this verifies that the CD image
actually can be read correctly by the installation
program.

When you have burned the CDs, put the first
one in your computer’s CD drive and boot from it.
You will see a Welcome screen, and after a few
seconds, a boot menu will appear. Choose
Installation with the arrow keys, and press Enter.
The Linux kernel will load, and after a minute or
so, you will see a screen that lets you choose the
language of the installation. The default is English
(US). Choose the language you want to use, then
use the mouse to click on the Next button in the
lower right-hand corner.

Next, you will see the Media Check screen.
Click on Start Check with CD1 still in the drive.

When the check has completed successfully for
the first CD, load each of the other CDs (2–5) into
the drive, and press Start Check until you have
checked all five CDs. If there are any errors, you
will have to figure out why they happened and

correct the problem. For example, in Figure 7, you
will note that there was an error when I inserted
the second CD. I removed the CD, checked to
make sure that I hadn’t dropped any Kung Pao
chicken on it, and tried it again. This fixed the
problem. If it hadn’t, I would have burned another
CD and tried again. If you experience something
like this and the CD is bad more than one time,
you will need to download the ISO image and
burn it again. Once you have checked all five CDs,
click on Next at the lower-right corner.

The next screen is the license agreement. Read
the agreement, click on Yes I agree, and click
Next. Now the installation program will analyze
your system and load the required modules. You
will then be asked whether this is a new installa-
tion or an update. Click on New Installation, and
then click Next. After a few moments, the clock
and time zone screen will appear. Choose your

region and time zone from the lists, then click
Next.

You will now choose which desktop to use.
Click on KDE, then Next.

The next screen is the Installation Settings
screen. Click on the Expert tab, near the top next
to Overview. Under the heading Partitioning, you
will see a proposed setup. It will typically have two
or three sections:

� A Swap section (typically hdb1).

� A Root (/) section (typically hdb2).

� A Home (/home) section (typically hdb3)—note:
this section may or may not be present.

It may show only two sections (Swap and
Root), but that’s not crucial. The important thing
is to make sure these sections are all on hdb (the
second hard drive), not hda (your Windows drive).
If the installation program is trying to install Linux
on the first drive (hda), you can click on Create
Custom Partition Setup, and on the next screen
select the second hard drive hdb, and click Next.
The installation program will shortly return to the
Installation Settings screen.

Next, you will need to verify how the system
boots. Click on Booting. Another screen will
appear with two tabs, Section Management and
Boot Loader Installation. Under Management,
choose whether you want to default booting to
Linux or Windows. Then click on the Boot Loader
tab (Figure 10).

The installation should make these selections
by default, but make sure they agree with what is
shown in Figure 10. Bootloader is GRUB, and the
location is /dev/hda. Click Accept once you have
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Figure 8. SUSE Linux desktop selection—click on
KDE to choose your favorite windowing GUI for
Linux. Figure 9. SUSE Linux partitioning dialog—verify

that the installation program is being installed on
the second hard drive!
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done this.
Now you are ready to commit to your choices

and install Linux. When the Installation Settings
screen appears again, click on Accept. A small win-
dow will pop up, asking you to confirm the instal-

lation. Click Install. The hard drive will now be par-
titioned and formatted automatically, and then the
installation will start from the first CD. When
everything has been installed from the first CD,
you will be prompted to insert the second CD.

Simply press the CD drive button to eject the
first CD, and insert the second CD. Unless you
have gotten creative and changed something in
the installed program list, you should need to do
this only twice, for the second and third CDs. This
process usually takes between 30 and 60 minutes,
and does not need to be monitored closely, so
you may want to do something else while it’s
going on and check back occasionally.

Once this has finished, there are a few more
steps. The installation will prompt you for a host-
name, a root password and network setup details.
The hostname is not too important; it’s simply a
name for your computer to distinguish it from any
other computers you have. The root password is
very important. Choose something that you won’t
forget. Otherwise, you will never be able to
update your system without a complete re-instal-
lation. For the network setup, choose automatic
setup via DHCP, unless you know what you are
doing and need something different.

I always skip the Online Update step during
installation, as I want to get through and verify
that everything works before I spend anymore
time waiting. Once you have your system running,
you can perform this step with YaST. You also will
be prompted to set up at least one user account.
Again, I like to set up only one user during instal-
lation, because this too can be managed later
with YaST.

Once the installation has finished and you
reboot your system, you will see a boot menu.

Depending on what you chose in the bootloader
installation step, if no action is taken, the system
will boot the default operating system (Linux or
Windows) after a brief pause. Verify that you can
run both operating systems, and you’re done.
Note that there should be an icon on your KDE
desktop that allows you to access your Windows
drive; however, you will not be able to access your
Linux drive from Windows, because it cannot rec-
ognize the filesystem.

THE ROOT PASSWORD IS
VERY IMPORTANT.  CHOOSE
SOMETHING YOU WON’T 
FORGET.
CONCLUSION
I have successfully made many dual-boot systems
for myself and others, and I think that this is the
easiest method, especially for Linux newbies,
because it seems to make sense intuitively to use
two drives, and it has a very low chance of inter-
fering with Windows. I hope this will enable you
to learn a lot more about Linux by making it easy
to run on your system without interfering with
your other tasks.�

Willy Smith is a musician who earns his
daily bread dispensing financial advice.
Besides being an avid Linux user and
FOSS advocate, he is a linguist, hardware
designer and truck driver. He usually
spends time off playing “tree-rock-
chakra” in wilderness areas, both in the
US and abroad.
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Figure 10. SUSE Linux GRUB installation dialog—
verify that your system will be booting from hda,
the first hard drive.

Figure 11. SUSE Linux installation CD dialog—the
installation program will prompt you when it
needs each of the CDs you have made.

http://www.tuxmagazine.com


Today, there is a booming Linux market demanding high-quality desktop and
laptop computers as well as numerous companies that are taking a stand
with their belief in and support of Linux by offering a growing number of
Linux PCs that are equal to or better than those found in stores.

I always have loved browsing my local electronics stores, and I get excited
looking at all the new gizmos and gadgets available for purchase. Recently, I
visited the computer section where there were several rows of desktop and
laptop name-brand computers alongside LCD monitors and other computer
paraphernalia, such as printers. I could not help but notice how saturated
the market is with Microsoft products, as there was not a single alternative
offered in competition to Windows XP.

Most new PC buyers never stop to think that there may be alternatives to
the Microsoft monopoly, and they really couldn’t care less—all they want is a
computer that works and functions properly, without the threat of viruses,
spyware and malware invading their machines. Yet it happens.

I remember several years ago when I purchased a brand-spanking-new,
high-tech, name-brand PC with all the extra bells and whistles offered at the
time. I was extremely satisfied with my purchase and thought Windows XP
was the best thing in the world. DSL was just being offered in my area, and I
was one of the first to jump on the bandwagon—being a trend-setter and
all. It wasn’t long, perhaps only a few weeks, and my new PC began running
more and more slowly each time I booted. I couldn’t understand what was
happening. How could my DSL connection be running more slowly than my
old 56K?

I searched for answers and learned how spyware/malware could piggy-
back one’s system, and that the so-called free programs I was
downloading/installing could infect my machine, and that my machine could

be infected merely by visiting the wrong sites. I determined that I might have
such a problem and downloaded and installed a recommended
spyware/adware program to check my PC. More than 100 programs were
discovered. My new PC had been compromised. I was angry at how vulnera-
ble Windows XP was to allow so many unauthorized programs to be
installed without my permission or knowledge. That was when I began my
search for an alternative operating system and discovered Linux.

I SEE VARIOUS FORUMS FOR NUMEROUS LINUX
DISTRIBUTIONS FILLED WITH FRUSTRATED
USERS WHO CAN’T GET ONE OR MORE PIECES
OF HARDWARE TO WORK CORRECTLY, AND I
KNOW MANY USERS SIMPLY GIVE UP THINKING
THAT LINUX IS TOO HARD TO INSTALL.

So, where do new Linux users purchase a computer desktop system or
laptop, pre-loaded with their favorite Linux distribution? My first Linux
machine was a hostile take-over where I completely reformatted my hard
drive with the Linux distribution I chose at the time. I was able to keep my
same PC by making a few minor adjustments (onboard sound non-opera-
tional). Many users become frustrated having to check each of their comput-
er components to verify Linux compatibility, and it seems that most databas-

Here They Are: the Linux PC Shops
Linux-friendly hardware stores for hassle-free purchases.
JAY KRUIZENGA
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es of tested components are out of date. I see various forums for numerous
Linux distributions filled with frustrated users who can’t get one or more
pieces of hardware to work correctly, and I know many users simply give up
thinking that Linux is too hard to install.

The problem does not lie in the particular components themselves but in
the various manufacturers who fail or refuse to release drivers that would
enable their hardware to work with Linux. That’s the real problem for all the
frustrated users who have given up on Linux due to nonworking compo-
nents. If you are out there and happen by chance (I don’t believe in chance)
to be reading this, there is a solution to the problem that has plagued Linux
far too long—buy a Linux PC.

With computer prices tumbling to all-time lows, there is no reason to
keep your existing PC, unless you are absolutely certain that the manufactur-
ers of your computer components are friendly to Linux. Although you cannot
yet purchase a new Linux PC right from your local computer store, buying a
Linux PC is much more simple. Simply get on the Net and search the numer-
ous options available from the growing number of Linux PC distributors you
will find there. With the advent of a Linux desktop revolution (predicted for
many years now), these Linux PC forerunners are ahead of the pack that is
certain to follow (the copy-cats). It is important to shop and support those
PC/component manufacturers and distributors who believe in Linux and rec-
ognize Linux as a valid operating system.

The point is to support those who are supporting Linux—that is the best
way to assist the growth of Linux and the desktop revolution explosion. This
being said, I have searched the Net for an assortment of Linux PC distribu-
tors who offer quality Linux systems that are competitive with the name
brands we see and hear about on a daily basis in our local computer stores.
The sampling of on-line stores listed below, in alphabetical order, are high-
quality distributors who are doing the Linux community a great service with
their offerings. Where noted, I have listed which distributors are exclusively
Linux—meaning no other operating systems are sold (unless by dual-boot).
To all Linux PC distributors, here’s a big thank you for your service! I apolo-
gize to all those companies I may have missed (and there are certain to be a
few); space did not allow me to list any more than I have.

EMPERORLINUX, INC.
� http://www.emperorlinux.com

� Desktop systems: no.

� Laptop systems: yes (13); from $1,160–$4,800 US.

� Extras: well-written user’s manual comes with all orders.

� Distributions pre-Loaded: you choose the distribution. Full hardware sup-
port on Fedora, Red Hat, Debian, Ubuntu, SUSE, Slackware and Mandriva.
Warranty varies from one to three years, depending on the manufacturer,
plus one-year of tech support.

� Notes: EmperorLinux has been offering quality systems with full hardware
support under Linux since 1999. It has supplied systems to engineers,
physicists, mathematicians, astronomers and more than 200 universities.
EmperorLinux is a well-known name brand in the Linux world. Its hand-
picked technical staff has more than 60 man-years of Linux experience.
EmperorLinux has received great reviews, and it offers a Linux experience
of the same quality as the large, name-brand laptop providers.

TUX EXPLAINS

50www.tuxmagazine.com

EmperorLinux’s Tarantula—Extremely Rugged Unit
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IBEX COMPUTERS, INC.
� http://www.ibexpc.com

� Desktop systems: yes (6); from $399–$649 US.

� Laptop systems: no.

� Extras: ability to customize systems.

� Distributions pre-loaded: Fedora Core 4.0 or 5.0, Red Hat Enterprise WS
4.0, SUSE 10.1 Professional or Ubuntu 5.0. IbexPC also will create a dual-
boot system with Windows Home or Professional.

� Warranty: one-year parts and labor warranty.

� Notes: IbexPC repeatedly has
been given a 5-Star rating by
Yahoo! as a top service award
winner. Numerous positive testi-
monials on the IbexPC Web site
speak well of the service
offered. The company offers
top-quality, on-time and afford-
able systems. IbexPC is not
exclusively Linux.

KOOBOX
� http://www.koobox.com

� Billed through Linspire, sold by Mirus Innovations.

� Desktop systems: yes (3); from $299–$739 US.

� Laptop systems: no.

� Extras: Mirus Innovations is no new-comer to the PC industry, serving
many Fortune 1000 clients and staffed by more than 4,000 certified tech-
nicians and engineers. It is ISO 9001 certified, and that means quality.

� Distributions pre-loaded: comes only with Linspire; however, the site does state
“because it is optimized to work with desktop Linux, you may be able to get it
to work with other Linux distributions, but there is no guarantee for this.”

TUX EXPLAINS

51www.tuxmagazine.com

WITH COMPUTER PRICES TUMBLING TO ALL-TIME LOWS, THERE IS NO REASON TO KEEP YOUR
EXISTING PC, UNLESS YOU ARE ABSOLUTELY CERTAIN THAT THE MANUFACTURERS OF YOUR
COMPUTER COMPONENTS ARE FRIENDLY TO LINUX.

IbexPC’s 4260 Intel Pentium D 2.66GHz Dual-Core
System The Koobox Mini—Lightweight Size, Heavyweight Value
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� Warranty: 90-days limited parts and labor war-
ranty with upgrades available (one year for $29
US or three years for $89 US).

� Notes: there’s something for every budget—
Koobox offers the Mini PC starting at $399 US,
with numerous upgrade options available. It’s
perfect for a small space and is similar in style
to the Apple MAC-Mini.

LINUXCERTIFIED, INC.
� http://www.linuxcertified.com

� Desktop systems: no.

� Laptop systems: yes (5); from $699–$1,299+
US.

� Extras: offers timely specials, from free laptop
bags to hardware upgrades.

� Distributions pre-loaded: Fedora Core 5,
Ubuntu 6.06 LTS or OpenSUSE 10 and optional
dual-boot with Windows XP.

� Warranty: standard one-year warranty covers
hardware and device drivers, and it’s expand-
able to three years. Plus, it includes an exclusive
five-year memory warranty.

� Notes: LinuxCertified was the winner of the
2004 Linux Journal Readers’ Choice Award as
well as the 2005 TUX Readers’ Choice Award.
LinuxCertified offers open-source training, and
it has trained IT professionals from Boeing,
NASA, Oracle, MIT, Compaq, the US Army and
more. LinuxCertified offers very high-quality
laptop systems, and it also offers limited 

refurbished systems for cost-conscious 
consumers.

R CUBED TECHNOLOGIES
� http://www.shoprcubed.com

� Desktop systems: yes (3); from $375–$1,249+
US.

� Laptop systems: yes (6); from $899–$1,159+
US.

� Extras: offers a full-range of hardware 
accessories.

� Distributions pre-loaded: Fedora Core 5,
OpenSUSE 10.1 or Ubuntu 6.06.

� Warranty: one-year limited warranty, expand-
able to three years.

� Notes: founded in 2003, R Cubed strives to
make itself the ultimate on-line computer
superstore for all your computer component
needs.

SEASCAPE, LLC.
� http://www.seascape.us

� Desktop systems: yes (9); from $376.99—
$1,072.99 US.

� Laptop systems: no.
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LinuxCertified’s Award-Winning LC2000 Series 
64-Bit

The LS1250 Laptop from R Cubed Technologies
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� Distributions pre-loaded: PCLinuxOS, Linspire or
any of the Ubuntu family.

� Warranty: guaranteed three-year warranty on
all computers sold.

� Notes: SeaScape is raising the standard on war-
ranties where most of the industry offers a lim-
ited one-year warranty, charging more for
extensions. SeaScape offers some very stylish
small footprint designs that look better than
most PCs offered through stores, with quality
ingredients as well. A relatively new company,
SeaScape plans on offering higher-end PCs in
the near future (as per its Web site).

SUB300.COM
� http://www.sub300.com

� Desktop systems: yes (3); from
$169.99–$759.99 US.

� Laptop systems: yes (2); from
$899.99–$1199.99.

� Extras: reduced rates for elementary, middle
school, high school and university users.

� Distributions pre-loaded: Linspire 5.0.

� Warranty: one-year warranty on parts and
labor.

� Notes: offers very low-cost and ultra-affordable
systems. Sub300 carries the unique zero-foot-
print PC (a computer inside the keyboard)—a
powerful system minus the box. It also offers
LCD monitors, hard drives, modems and the
Sonos digital music system (which lets you play
the same song or different songs in up to 32
rooms simultaneously).

SYSTEM76
� http://www.system76.com

� Desktop systems: yes (4); from $799–$1,599
US.

� Laptop systems: yes (3); from $799–$1,099+
US.

� Extras: free shipping for orders of more than
$800 US and provides the ability to customize
systems.

� Distributions pre-loaded: Ubuntu.

� Warranty: one-year limited warranty, plus tech
support expandable to three years.

� Notes: System76 offers excellent support, inno-
vative hardware (guaranteed to be fully compat-
ible with Linux) and clear documentation.
System76 offers only Linux systems. Its various
computers are named after exotic animals, such
as serval, bonobo, gazelle, sable and so forth.

Z-TECH SERVICES
� http://www.ztechshop.net

� Desktop systems: yes (4); from $75–$579.99 US.

� Laptop systems: no.
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Stylish and Sleek — SeaScape’s Signature Series

How about a Zero-Footprint PC offered by Sub300?

System76’s Koala Mini—Lots of Power in a Tiny PC

http://www.sub300.com
http://www.system76.com
http://www.ztechshop.net
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� Extras: free shipping in the US. Will install virtu-
ally any distribution you request.

� Distributions pre-loaded: SUSE Linux 10.1 by
default (with the exception of their Sub-100 PC,
which comes with Xubuntu by default). More
than 75 distributions are offered.

� Warranty: because of the low mark-up, Z-Tech
does not offer a warranty or official technical
support, though the company will make every
attempt to solve any issues by e-mail. All sales
are final.

� Notes: Z-Tech sells much more than PCs, includ-

ing CDs, Linux and BSD apparel, merchandise,
books and so on. It sells Linux and BSD on every
format, including USB thumbdrives. It’s offerings
are exclusively Linux and BSD. Z-Tech distributes
worldwide, and 20% of the profit from each
order is donated back to open-source software
development.

FINAL THOUGHTS
I dream of the day when Linux PCs will sit right
alongside Windows and Mac computers in stores.
Today is not that day. As Linux was born and
evolved over the Internet, I believe that the power
of the Net to spread the Linux message is yet to be
seen. Although there are certain drawbacks to

ordering a PC on-line, such as not having the ability
to touch, feel and play with the unit prior to 
purchase, I still think this will not deter from the
success of the companies listed above who are bold
enough to stand forward and take a chance on
what we Linux users know is the very best OS out
there. Many new PC buyers order via phone each
and every day—just look at Dell’s success! PC buyers
need to be assured that the system will work as
advertised, right out of the box, and that assurance
is absolutely crucial to the future success of Linux if
we are to be taken seriously. We need Linux PCs!

There’s no need to tinker with existing machines
or outdated components, and no need for frustrat-
ed users to voice their numerous incompatibility
complaints to user forums. Go with what does work
and purchase a new Linux PC from one of the dis-
tributors listed above. If your distribution of choice is
not listed anywhere in the pre-loaded options, that
does not mean it won’t work. The best thing to do
in that case is bookmark the Web site for the PC
you are interested in purchasing, and send the link
to the distribution’s technical support team for a
compatibility check. Chances are, if the PC works
for one distribution, it will work for most of them.
But, it’s always best to be safe rather than sorry.�

Jay Kruizenga, a former Marine, is an
accomplished Marketer (specialty: E-
Commerce), business owner and aspiring
author. He has a deep love for everything
pertaining to Linux.
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Z-Tech’s Power AMD Athlon 64 3500" System Only $75 US, Offered by Z-Tech
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“Will it run my games?” That is always one of the first questions posed to
me by people who are considering the switch to Linux from Windows.
Unfortunately, I am usually forced to rattle off the six or seven recent com-
mercial titles that include the penguin on their supported operating system
list. The tides have waxed and waned over the years, but with many recent
blockbusters, such as iD’s Doom 3 and Quake 4, Bioware’s Neverwinter
Nights and Epic Games’ Unreal Tournament 2004, coming to Linux—not to
mention advancements in graphics drivers from NVIDIA and ATI—it’s begin-
ning to look as if our beloved operating system is steadily becoming a viable
gaming platform.

INSTALLATION ON A LINUX SYSTEM IS ACTUALLY
MORE INTUITIVE THAN ONE MIGHT THINK.

Because these games are primarily developed for the Windows’ crowd, it
only makes sense that, as a Linux-based publication, we would be interested
to see how well the Linux iterations hold up. Unfortunately, we cannot pro-
vide a direct comparison through and through. However, we can do our best
to compare the two and use the conclusions to evaluate the current state of
gaming in Linux.

With Epic’s Unreal Tournament 2007 just over the horizon, I decided to
take an in-depth look at the experiences of installing, patching and playing
Unreal Tournament 2004 (UT2k4) in both Windows and Linux and was sur-
prised to see what I found.

INSTALLATION
Installation on a Linux system is actually more intuitive than one might think.
The developers have included an executable installer right on the DVD. This

simply means that you can open the file aptly named linux-installer.sh to
begin the installation (Figure 1). After reading the lengthy License Agreement
(you read those, right?), you are greeted with a fairly intuitive installer win-
dow (Figure 2). Unlike its Windows counterpart, the UT2k4 installer has all

Unreal Tournament 2004: Linux vs. Windows
Battle of the boxes.
TRAVIS KEPLEY

Loki Games was one of the pioneers in bringing Windows-based games
to Linux. Its installers are still used to this day.

NOTE:

If you would like the ability to create directories during the install, you
either can run the installer as root or create the directories in your home
folder ahead of time. Also, you have the option to install both the
OpenAL and SDL12 source code if you want to fiddle around with some
code, which, like many of the unchecked options, is far from necessary.

ADVANCED USERS:

http://www.tuxmagazine.com


the major options on one page (as is par for the
course for most Loki-based installers).

I like to keep all my games, as well as the sym-
bolic links (a fancy term for shortcut), in one direc-
tory in my home folder. Unfortunately, the installer
lacks the ability to create these directories for me.
This, however, will likely not pose any problem for
most users.

All that’s left is to click Begin Install, type in your
CD-key and play your game.

Of course, anyone who has played a computer
game, such as UT2k4, already knows the joys of
installing a game in Windows and can tell Linux
has topped it in many areas. There is very little
need to detail the typical Windows quirks, such as
the restarts, clicking Next incessantly and praying

you don’t have to fiddle with Gamespy Arcade or
a new DirectX version. Whew! It makes me anx-
ious just thinking about the hassle!

PATCHING
One of the bittersweet requirements of on-line PC
gaming is keeping the game up to date. Although
it discourages cheating and often adds new fea-
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Figure 2. The UT2k4 Loki Installer for LinuxFigure 1. The Linux Installer comes before the Windows Installer. Is Epic trying to tell us something?
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tures, the patching process can become tedious if
the developer makes the procedure more difficult
than necessary. Updating to the latest version 
of UT2k4 is a spot where the Windows client 
really shines. Epic has made it is as simple as
going to the Unreal Tournament Web site 
(http://www.unrealtournament.com) and down-
loading the latest patch in a self-installing/extract-
ing executable file. A double-click and a few Next
buttons later, and you’re back in the fray.

The Linux version gets a bit stickier, but it isn’t a
terrible pain assuming you feel comfortable over-
writing files yourself. Simply go to the same site as
before, but instead you have to get the latest Linux
patch, which is in a tarball (a type of compression).
Once the file is downloaded, simply use a tool, such
as Ark, to extract the files. All that is left is to copy
the newly extracted files over top of the existing
files in your UT2k4 directory, overwriting as neces-
sary (Figure 3).

I believe that this method is much more of a
pain, and for the novice, it can be a quick turn-off
to gaming with Tux. Hopefully, Epic will correct this
with the upcoming release of UT2007, as Epic is
known to update its software frequently once it is
released.

PLAYING
What good is talking about the installations and
patching if we aren’t going to play the game itself?
Well I’ll tell you—it isn’t nearly as good and is
nowhere near the fun! As the game loads, you 
are presented with perhaps the coolest novelty of
the Linux version. To the right of all the logos is 
a picture of Tux sitting fat and happy (Figure 4). 
I assume this is where some of the art on
http://www.kde-look.org with Tux holding an Unreal
rocket-launcher was inspired. I must say that I had a
big grin the first time I saw the chubby guy featured
as part of a retail game’s splash screen. Once in the

game, aside from a few changes in sound server
selections, I was hard pressed to find any major dif-
ferences in the Windows and Linux versions of the
game—that is, until I compared frame rates.

SOME PITFALLS
Unfortunately for Linux, I received between a 5–15
frame-per-second (FPS) drop when running the bot-
match demo. This isn’t a huge problem for me,
because the average FPS was still well more than
100. But for those with older hardware, this could
prove to be a disadvantage—especially in an on-line
environment. This slight drop in speed comes from
the OpenAL and SDL12 mentioned earlier. Both
technologies, pioneered by none other than Loki,
are used to provide a compatibility layer so that
games are easily ported to multiple platforms. In
other words, by using the same code, it is very easy
for programmers to make a game that can run on
Windows, Mac OS, Linux and even the likes of BSD
and Solaris. The price of it comes in the form of a
slight drop in speed. Of course, this is much better
than running an emulator, and it is fast enough that
most people won’t even notice. It is also worth
mentioning that, due to the compatibility layer,
some visual features are supposedly missing, but I
have yet to notice it in the game even with visuals
set at full in Windows and Linux.

I MUST SAY THAT I HAD A BIG
GRIN THE FIRST TIME I SAW
THE CHUBBY GUY FEATURED
AS PART OF A RETAIL GAME’S
SPLASH SCREEN.

DIVERSIONS

57www.tuxmagazine.com

Figure 3. Copy and overwrite all—what a pain. Figure 4. Maybe he’s too cute for fragging?
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It should be mentioned that prior to patching
the Linux version, I had a few stability issues—all
of those were taken care of, along with some
speed improvements with the latest patch. Of
course, this means you must go through the fairly
tedious patching process to alleviate the problems
if you happen to run into them (Figure 5).

CONCLUSIONS
Without a doubt, one of the hardest things to do
as a geek is convince my gamer friends to switch
to Linux. The moment they find out their favorite
game is not Linux-compatible, they shy away. Let’s
face it, most gamers need as much hard disk real
estate as they can get and would rather not waste

their time with dual-booting—especially consider-
ing the bulk of their computing experience is
spent playing their favorite games.
Although there were some small issues, Unreal
Tournament 2004 is an excellent example of
doing a Linux port well. Epic employees have
openly stated that UT2k7 will be available for play
in Linux. If the trend continues, it might not be
long before my buddies and I are fragging each
other in Linux, claiming dominance on the game
and of our favorite distribution.�

Travis Kepley is the co-owner of a comput-
er repair shop in Lewsiville, North Carolina
(http://www.kepleyscomputers.com). He
recently graduated with a degree in English
Literature from UNC-Greensboro. He is an
avid gamer, musician and loves spending
time in his recording studio, which can be

found at http://www.goodbeef.net.
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Figure 5. Linux? Check. UT2k4 Check. Sniper Rifle? Check.

Developers: Epic Games, Digital Extremes

Publishers: Atari (Win/Linux), MacSoft (Mac)

Designer: Steven Polge

System Requirements: 1GHz processor, 128MB
of RAM, DirectX 9.0b or OpenGL, 64MB video
card and 2.6 kernel

URL: http://www.unrealtournament.com

Price: $15.99 US (Amazon)

GAME INFORMATION:

http://www.kepleyscomputers.com
http://www.goodbeef.net
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Free, open-source games are mostly known to be small, fun and inventive.
The FOSS community is not exactly known for big games with complicated
plots, graphics, music and so forth—or so they say.

However, there is a gaming genre—the oldest of all to be exact—that a
lot of penguin gamers are familiar with and that Linux has inherited from the
old times of UNIX domination. Yes, I am talking about adventure and role-
playing games (RPGs). Since the ancient classic RPGs, such as Nethack (which
is one of the oldest games still in development) and Rogue, the penguins
have been taking their role playing rather seriously. And, I am willing to
argue, that the game I present here continues the tradition and applies it to
more modern times with 3-D graphics, quality music and sound—and, of
course, network playing.

Planeshift started as a graphical multiuser dungeon (MUD) many years
ago. Although the graphics and the interface have changed enormously
since those days, it is important to note that the world and main logic
behind the game has not changed much. It is very typical of Planeshift that
nothing gets into the world or game unless it fits in that world and its logic
flawlessly. This is is one of the reasons why true role players love it.

So, here is a short introduction into the wonderful world of this great free
(as in beer) and open-source, massively multiplayer, on-line role-playing game
(MMORPG). Hold on to your hat; this will be a pretty wild trip!

STORY AND WORLD
The whole story takes place in a magical place called Yliakum, which consists
of nine circular layers, the lowest of which are under water. Light and energy
radiates from a giant crystal that the inhabitants call the Crystal Sun. What
the races do not know is that their beloved Yliakum is actually in an enor-

Planeshift
A graphically appealing, addictive Linux game.
MATIJA SUKLJE
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Figure 1. Planeshift takes place in Yliakum—a huge hollow stalactite.
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mous hollow stalactite.
A shortened version of the publicly known his-

tory is that two young gods, Talad and Laanx,
ruled together in perfect harmony over Yliakum
and created the world. But, when they came to
the part where they started creating intelligent
life—Laanx and his Lemurs and later on Talad and
his Kran—jealousy sprang a crack between the
two gods, and Laanx departed in a grudge from
Talad. To the present day, they have not made
peace, regardless of Talad’s efforts to make peace
once more.

The world of Yliakum is so full of crystals
(magical and otherwise) that they also are used as
currency. The official currency is—as in real life—
made from pieces of different value. Tria is the
basic currency, with a Hexa being worth five Tria,
an Octa being worth 50 Tria and the Circle being
worth 250 Tria.

RACES, SKILLS AND JOBS
There are a dozen playable races—either created

by the two gods or those who found their way
into the world from the outside.

From the human races are the pale and inven-
tive Xacha and the robust and practical Ylians.
Elven races consist of the ancient amphibious
Nolthrir and the dark-loving Dermorians. From the
dwarves are the Stonebreaker clan, which is more
inclined to mining, and the Hammerwielder clan,
which finds joy in smithing and crafting. Among
the other races one finds the already-mentioned
intelligent but fragile Lemurs, the tough silicon-
skinned and gender-neutral Kran, the horned
Diaboli with their resistance to magic, Ynnwns—
the most versatile of them all made by the cross-
ing of Diaboli with elves, the wild and strong
feline Enkidukai and the slim-winged Klyros.

Each of these races has its own special traits,
but there are no restrictions on what job(s) or
skills players can have their characters learn. In
Planeshift, any character can master any skill if the
character puts enough effort into it. Planeshift, for
a long, long time, has supported skill-based level-

ing. The idea behind it is that a player’s character
is free to develop and make his/her/its (remember
Kran?) own destiny. If players desperately want to
make a Kran who is great in herbal lore and a
master of all six magical ways, they can do so.
And, if those same players decide after a few
months that their Krans also should learn fishing
and martial arts, the characters are free to learn
those skills as well.

I’ve already mentioned magic, so I think it is
high time to dedicate a paragraph to it. In
Planeshift, there are six magic ways—Crystal Way,
Azure Way, Red Way, Dark Way, Brown Way and
Blue Way. Each way has two neighboring ways
with which it works well and an opposing way
(Figure 3). Each way has its own magical stones
called glyphs. To form a spell, you need to com-
bine glyphs into a specific combination in order
for the spell to work.

Other skills vary from standard fighting (melee,
sword, axe, daggers and so on) and crafting skills
to more interesting, less widespread skills, such as
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Figure 2. A Group of Characters Meet Figure 3. Diagram of the Magic Ways Figure 4. A View of a Village
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special fighting techniques, cooking, herbalism
and so on.

Each level of skill needs to be learned first on a
theoretical level from a trainer and later on be
trained in praxis until that level is mastered.

INTERFACE, LOOK AND FEEL
So far, I’ve described the world itself and nothing
about how the game looks. There is a very simple
reason for this—Planeshift is mostly about the
experience, the story and a world that works
(although logically works only in itself), and what
I’ve described so far scratches only the surface of
it all.

The overall look and feel of the graphics, inter-
face, music and sound effects are quite enjoyable.
Do not expect to get the same level of detail that
you would get in Neverwinter Nights 2 though—
not yet. The graphics are quite detailed, and a lot
of effort is put into quality and making sure that
everything works together as a whole (and not as
though it was thrown together). The animation of
characters is good—not yet perfect, but improving
all the time.

The interface and interaction are things that
some players might find new, but once you get
used to it, it’s logical and enjoyable. Character
movement is done via the keyboard (WSAD or
arrow keys, Shift to run, Alt to strafe, spacebar for
jumping), and targeting an object or character is
done with the mouse.

The part that takes the most time getting used
to is interaction with NPCs (non-playable charac-
ters) and pets. This is not done with conversation
menus (as many are used to), but players have to
type their conversations—just like they would do
with another PC (player character). NPCs in
Planeshift are characters just like any others—that

is the big plan. The problem is that to make this
work, the NPCs have to be intelligent enough to
understand and make conversation successfully.
So far, they understand simple phrases and also
synonyms, which makes them usable but far from
perfect. However, Planeshift is getting there—at
least in the aspects of thinking about every possi-
ble situation and having continuing development.

THE END?
In summary, Planeshift already is a nice, playable
MMORPG in which the role-playing community is

a key part, and there is still space left for improve-
ment.�

Matija Suklje is a 23-year-old law stu-
dent and member of Cyberpipe from
Ljubljana, Slovenia, who has been inter-
ested in Linux and F(L)OSS since his
early high-school days when he first met
with Slackware. Currently, his favourite
distribution is Gentoo. You can contact

him via e-mail at matija.suklje@rutka.net,
or look for more contact information on his home page
(http://matija.suklje.name).

DIVERSIONS

61www.tuxmagazine.com

Figure 5. Having a Virtual Picnic
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